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Περίληψη 

Το παρόν τεύχος είναι η τεκµηρίωση του λογισµικού «Υδρογνώµων» καθώς και ο οδηγός 
χρήστη. Αρχικά γίνεται µία συνοπτική παρουσίαση των λειτουργιών του λογισµικού. Στην 
συνέχεια ακολουθεί η εισαγωγή στην χρήση του λογισµικού, στις βασικές ρυθµίσεις καθώς 
και στις κοινές λειτουργίες των τµηµάτων του. Παρουσιάζεται έπειτα το τµήµα επεξεργασίας 
των δεδοµένων των χρονοσειρών, της απεικόνισής τους και των ειδικών επεξεργασιών. 
Γίνεται εκτενής παρουσίαση στις λειτουργίες παρεµβολών (υπολογισµός στάθµης - παροχής, 
στάθµης - αποθέµατος, επιφάνειας) καθώς και στον υπολογισµό της εξάτµισης. Κατόπιν 
παρουσιάζονται οι λειτουργίες που αφορούν τις γεωγραφικές οντότητες (γεωγραφικά 
αντικείµενα). Τέλος αναλύεται η ειδική εφαρµογή για τον υπολογισµό των ισοζυγίων 
ταµιευτήρων. Σε χωριστά παραρτήµατα παρουσιάζονται το συνοδευτικό λογισµικό, η 
περιγραφή ορισµένων επεξεργασιών καθώς και η περιγραφή των αρχείων κειµένου. 

 

Abstract 

This report documents the "Hydrognomon" software and constitutes its user manual. First, the 
features of the software are briefly presented. Then, the user is introduced to essential 
operations and options and to the functionality that is common to all components. Next, the 
Timeseries processing module is presented, including details of the interpolation functions 
(calculation of discharge and of reservoir volume and surface) and of evaporation calculation. 
Next, the functionality concerning the management of geographical entities is presented. 
Finally, the application for the calculation of reservoir balance is explained. Appendices 
describe helper software, certain data processing operations, and file format. 
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1 Γενική παρουσίαση του λογισµικού «Υδρογνώµων» 

Το λογισµικό «Υδρογνώµων» είναι µέρος της οµάδας προγραµµάτων που κατασκευάστηκαν 
στα πλαίσια του έργου «Εκσυγχρονισµός της εποπτείας και διαχείρισης του συστήµατος των 
υδατικών πόρων ύδρευσης της Αθήνας» από το Εθνικό Μετσόβιο Πολυτεχνείο. Το λογισµικό 
εκτελεί τις παρακάτω λειτουργίες: 

��∆ιαχείριση της υδρολογικής πληροφορίας (υδροµετεωρολογικά δεδοµένα - ιδιότητες 
γεωγραφικών αντικειµένων) σε συνεργασία µε την κεντρική βάση δεδοµένων. 
Ουσιαστικά το λογισµικό «Υδρογνώµων» είναι το περιβάλλον χρήστη της βάσης 
δεδοµένων. 

��Επεξεργασία υδρολογικών δεδοµένων, που αφορά στις επεξεργασίες χρονοσειρών µέσω 
των κατάλληλων µεθοδολογιών και αλγορίθµων. 

Το λογισµικό «Υδρογνώµων» είναι σχεδιασµένο για χρήση σε λειτουργικά συστήµατα 
Microsoft Windows NT ή νεότερα (Windows 2000 ή Windows XP). Έτσι υιοθετεί τον 
σχεδιασµό του παραθυρικού λογισµικού για την αλληλεπίδραση µε τον χρήστη κάνοντας 
χρήση προσιτών µέσων όπως παραθύρων, κουµπιών, µενού κ.α. 

Επιπλέον το λογισµικό «Υδρογνώµων» παρέχει δυνατότητες συνεργασίας µε εξωτερικές 
εφαρµογές όπως το Microsoft Excel αλλά και απεικόνιση των οντοτήτων της βάσης 
δεδοµένων µέσω του προγράµµατος ArcGIS. 

Το παρόν τεύχος είναι η τεκµηρίωση καθώς και ο οδηγός χρήστη για το λογισµικό 
«Υδρογνώµων». Μέρος του κειµένου υπάρχει σε µορφή “windows help” - κείµενο βοήθειας 
εγκατεστηµένη µε το λογισµικό. Η ανάκτηση του κειµένου βοήθειας γίνεται µε χρήση των 
κατάλληλων µενού του λογισµικού «Υδρογνώµων» ή πατώντας ανά πάσα στιγµή το πλήκτρο 
“F1”, οπότε λαµβάνεται ειδική βοήθεια (context-sensitive help). 
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Στην συνέχεια, γίνεται µία εισαγωγή στο λογισµικό «Υδρογνώµων» µε µια σύντοµη 
παρουσίαση σε κάποιες από λειτουργίες του.

Σύνδεση µε τη βάση δεδοµένων 
Οι χρήστες συνδέονται µε τη βάση δεδοµένων 
χρησιµοποιώντας κωδικό και σύνθηµα. ∆ιαφορετικοί 
χρήστες έχουν διαφορετικά δικαιώµατα στη βάση 
δεδοµένων. Κάποιοι έχουν δικαίωµα ανάγνωσης µόνο· 
άλλοι µπορούν να προσθέσουν ή να τροποποιήσουν 
δεδοµένα. Λογισµικό της Oracle, όπως το Oracle 
Enterprise Manager, που περιλαµβάνεται στο server, 
πρέπει να χρησιµοποιηθεί για την προσθαφαίρεση 
χρηστών και την χορήγηση δικαιωµάτων πρόσβασης. 

Server βάσης δεδοµένων 
Όλα τα δεδοµένα αποθηκεύονται στον 
διακοµιστή (server). 

∆ίκτυο

Clients 
Ο «Υδρογνώµων» τρέχει σε clients, που συνδέονται µε τη βάση 
δεδοµένων µέσω του δικτύου. 
Αν ο server της βάσης δεδοµένων τρέχει Windows, τότε ο 
Υδρογνώµων µπορεί να τρέξει και στον server. 

Αρχιτεκτονική Client-Server
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Μετρητικοί σταθµοί (Stations) 
Τα δεδοµένα που αποθηκεύονται για ένα µετρητικό σταθµό περιλαµβάνουν όνοµα, 
τοποθεσία, συντεταγµένες, φορέα στον οποίο ανήκει ο σταθµός, τύπο (µετεωρολογικό, 
υδροµετρικό, κλπ.), περίοδο λειτουργίας, αν είναι ακόµα ενεργός, και αν είναι 
τηλεµετρικός. 

∆ίγλωσσα πεδία 
Τα πεδία της βάσης δεδοµένων διατίθενται σε δύο γλώσσες (όπως φαίνεται, για 
παράδειγµα, στο όνοµα του σταθµού παραπάνω). Αυτό είναι ιδιαίτερα χρήσιµο αν η βάση 
δεδοµένων είναι προσπελάσιµη από δίγλωσσο web site. Όλα τα πεδία είναι σε δύο 
γλώσσες, ακόµα κι αν αυτό δεν φαίνεται παραπάνω· για παράδειγµα, ο νοµός στην 
παραπάνω φόρµα φαίνεται µόνο στα ελληνικά, γιατί τα ονόµατα των νοµών ρυθµίζονται 
σε άλλη φόρµα: 



 4

Κωδικοί σταθµών 
Οι σταθµοί προσδιορίζονται από το id 
τους, που χορηγείται αυτόµατα από το 
λογισµικό όταν εισάγεται νέος 
σταθµός στο σύστηµα. ∆ιατίθενται 
πρόσθετα πεδία για την αποθήκευση 
εναλλακτικών κωδικών, π.χ. ήδη 
υπαρχόντων κωδικών που έχουν δοθεί 
από το φορέα ή από τον WMO. 

Πλοήγηση στη βάση δεδοµένων 
Τα κουµπιά στο πάνω µέρος χρησιµοποιούνται για µετάβαση στον προηγούµενο ή επόµενο 
σταθµό, και για πρόσθεση, αφαίρεση, και τροποποίηση σταθµών. Επίσης, το πεδίο «Μετάβαση» 
(Goto) µπορεί να χρησιµοποιηθεί για µετάβαση σε συγκεκριµένο σταθµό, εφόσον ο χρήστης 
θυµάται το id. Εναλλακτικά, διατίθεται συνοπτικός πίνακας που παρουσιάζει όλους τους 
σταθµούς σε αλφαβητική σειρά. 

Παρατηρήσεις (remarks) και πολυµέσα (multimedia) 
Οποιαδήποτε πληροφορία δεν µπορεί να ενταχθεί στα υπόλοιπα πεδία, από µικρά σηµειώµατα 
(remarks) µέχρι κείµενα απεριόριστου µήκους, µπορεί να εισαχθεί στο πεδίο παρατηρήσεων. 
Επίσης, φωτογραφίες και βίντεο των σταθµών µπορεί να εισαχθεί ή να προσπελαστεί πατώντας 
το κουµπί «Πολυµέσα» (multimedia). 
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Γεγονότα (events) 
Τα γεγονότα (events) είναι ένα είδος ηλεκτρονικού ηµερολογίου. Οποιοδήποτε 
γεγονός, όπως βλάβη, επισκευή, ή παρατήρηση καιρού, µπορεί να εισαχθεί εδώ. 
Πατώντας πάνω σε ένα γεγονός, εµφανίζονται λεπτοµέρειες στα πεδία παρατηρήσεων. 
Oι λεπτοµέρειες αυτές είναι µικρά σχόλια ή και κείµενα απεριόριστου µήκους. 
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Όργανα (instruments) 
Πατώντας πάνω στο κουµπί «Όργανα»  
(instruments) εµφανίζονται τα όργανα 
του σταθµού. Υπάρχει και πάλι 
συνοπτικός πίνακας µε όλα τα όργανα σε 
αλφαβητική σειρά, και κάθε όργανο έχει 
τις δικές του παρατηρήσεις και γεγονότα.

Χρονοσειρές (Time series)  
Όταν πατηθεί το κουµπί «Χρονοσειρές» (Time series) στη φόρµα οργάνων εµφανίζονται οι 
χρονοσειρές του συγκεκριµένου οργάνου· όταν πατηθεί το «Χρονοσειρές» στη φόρµα σταθµών 
εµφανίζονται όλες οι χρονοσειρές του σταθµού, που περιλαµβάνουν και τις χρονοσειρές όλων των 
οργάνων και χρονοσειρές που δεν αντιστοιχίζονται σε κάποιο όργανο (για παράδειγµα, 
εξατµισοδιαπνοή που έχει προκύψει µε την µέθοδο Penman). 

Για κάθε χρονοσειρά αποθηκεύονται 
γενικές πληροφορίες, όπως όνοµα 
µεταβλητής, όνοµα χρονοσειράς, 
χρονικό βήµα, παρατηρήσεις, και 
γεγονότα. 
 
Μπορούν επίσης να αποθηκευτούν 
χρονοσειρές που δεν αντιστοιχίζονται 
σε σταθµούς, αλλά σε άλλες 
γεωγραφικές οντότητες, όπως λεκάνες 
απορροής· αυτό είναι ιδιαίτερα 
χρήσιµο για επιφανειακές 
βροχοπτώσεις. 
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∆εδοµένα χρονοσειράς 
Η φόρµα αυτή (Time series data) 
είναι ειδικά σχεδιασµένη για 
εύκολη και αποτελεσµατική 
οπτικοποίηση και διαχείριση 
χρονοσειρών. 

Σηµαίες (flags) 
Οι εγγραφές των χρονοσειρών έχουν 
σηµαίες  (flags) ώστε να σηµαίνονται 
λάθη ή άλλες αξιοσηµείωτες 
περιπτώσεις. ∆ιάφορες σηµαίες 
διατίθενται για τιµές εκτός ορίων, 
ύποπτες τιµές, χιόνι, τιµές που έλλειπαν 
αλλά συµπληρώθηκαν, κλπ. Υπάρχουν 
επίσης γενικές σηµαίες, χωρίς 
συγκεκριµένη σηµασία, για γενική 
χρήση. Συνολικά υπάρχουν 30 σηµαίες, 
και κάθε εγγραφή µπορεί να έχει 
οποιονδήποτε συνδυασµό αυτών. 
Οι χρονοσειρές µπορούν να 
οπτικοποιούνται µε ή χωρίς σηµαίες, 
όπως φαίνεται δεξιά. 

Φίλτρα (Filters) 
Μπορούν να χρησιµοποιηθούν φίλτρα 
(filters) για απόκρυψη κάποιων από τις 
εγγραφές, ώστε να εµφανίζονται µόνο 
εγγραφές που περνούν από το φίλτρο. 
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Φίλτρα 
Όταν έχει οριστεί ένα φίλτρο, µπορεί να 
ενεργοποιείται ή να απενεργοποιείται µε 
το σχετικό κουµπί της γραµµής 
εργαλείων ή µε το πλήκτρο F9. 

Πολλαπλές χρονοσειρές 
Περισσότερες από µία χρονοσειρές 
µπορούν να εµφανίζονται ταυτόχρονα. 
Εγγραφές µε την ίδια ηµεροµηνία και ώρα 
εµφανίζονται στην ίδια γραµµή. 
Ηµεροµηνίες και ώρες που υπάρχουν σε 
µια χρονοσειρά αλλά δεν υπάρχουν σε 
άλλη προσδιορίζονται από διαγώνιες 
γραµµές. 
 
Μπορεί να εµφανίζεται απεριόριστος 
αριθµός χρονοσειρών, η µια δίπλα στην 
άλλη, µε ή χωρίς τις σηµαίες. 
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Αποθήκευση σε αρχεία 
Οι χρονοσειρές µπορούν να γράφονται σε 
αρχεία. Αυτό είναι ιδιαίτερα χρήσιµο για 
χρήστες που θέλουν να τροποποιήσουν 
χρονοσειρές και δεν θέλουν ή δεν έχουν 
δικαίωµα να τις αποθηκεύσουν στη βάση 
δεδοµένων. Τα αρχεία είναι σε απλή 
µορφή ASCII ώστε να µπορεί κανείς να 
τα επεξεργαστεί µε απλό διορθωτή 
κειµένου ή λογιστικό φύλλο (τύπου 
Excel). 

Πινακοποίηση (view as 
table) 
 
Ωριαίες, ηµερήσιες και 
µηνιαίες χρονοσειρές µπορούν 
αυτόµατα να προβάλλονται σε 
µορφή πίνακα. Για 
παράδειγµα, στις ωριαίες 
χρονοσειρές ο πίνακας 
περιέχει τις τιµές ενός µήνα, 
έτσι ώστε οι στήλες να 
αντιστοιχούν στις 24 ώρες και 
οι γραµµές στις µέρες του 
µήνα. Το άθροισµα ή η µέση 
τιµή κάθε γραµµής ή στήλης, 
καθώς και άλλα στατιστικά, 
εξάγονται αυτόµατα. 

Ευκολίες όπως ο αυτόµατος χρωµατισµός τιµών (Highlight) µε συγκεκριµένα χαρακτηριστικά 
διευκολύνουν τον εντοπισµό λαθών και ακραίων επεισοδίων.

Τροποποίηση δεδοµένων 
Οι χρήστες µπορούν να τροποποιούν τις 
χρονοσειρές, τιµές και σηµαίες. Οι 
τροποποιηµένες τιµές εµφανίζονται µε 
πλάγια γράµµατα. Οι χρήστες µπορούν να 
γράψουν τις αλλαγές στη βάση δεδοµένων, 
υπό τον όρο να έχουν τα κατάλληλα 
δικαιώµατα πρόσβασης. 
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Επικοινωνία µε άλλες εφαρµογές 
Τα δεδοµένα µπορούν να µεταφερθούν προς και από άλλες εφαρµογές µε αντιγραφή (Copy) 

και επικόλληση (Paste). 

Επεξεργασία χρονοσειρών 
Οι διαθέσιµες δυνατότητες επεξεργασίας χρονοσειρών περιλαµβάνουν έλεγχο ακραίων 
τιµών, διόρθωση ηµεροµηνίας και ώρας (εντοπισµό και αναίρεση διαταραχών στο χρονικό 
βήµα), συµπλήρωση ελλειπουσών τιµών, εξαγωγή χρονοσειρών µεγαλύτερου χρονικού 
βήµατος, γραµµικές πράξεις, υπολογισµό εξάτµισης, και παρεµβολή σε καµπύλες 
(υπολογισµός παροχών από στάθµες και καµπύλες στάθµης-παροχής, υπολογισµός 
αποθέµατος από στάθµη και καµπύλη στάθµης-όγκου ταµιευτήρα, κ.ά.) 
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Ταµιευτήρες (Reservoirs) 
Εκτός από σταθµούς, στη βάση αποθηκεύεται πληθώρα άλλων τύπων γεωγραφικών οντοτήτων, σε 
φόρµες παρόµοιες µε αυτή των σταθµών. Για τους ταµιευτήρες, εκτός από τα γεωγραφικά στοιχεία, 
αποθηκεύονται καµπύλες στάθµης-επιφάνειας-όγκου (Stage-Area-Volume), και συντελεστές 
διαφυγών (Leakage). 

Φράγµατα (Dams) 
Για τα φράγµατα αποθηκεύονται τεχνικά χαρακτηριστικά του φράγµατος, µεταξύ των οποίων και 
καµπύλες στάθµης-παροχής υπερχειλιστή.
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Υδραγωγεία (Aqueduct) 
Για τα υδραγωγεία µεταξύ άλλων αποθηκεύονται σκαριφήµατα διατοµών και καµπύλες 
παροχετευτικότητας. 

Γεωτρήσεις (Boreholes) 
Για τις γεωτρήσεις µεταξύ άλλων αποθηκεύονται περιγραφή οπής (hole), περιγραφή σωλήνωσης 
(pipes), υδατοπερατά στρώµατα (per. layers) και λιθολογική τοµή (lith. section). 
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2 Εισαγωγή στην χρήση του λογισµικού 
«Υδρογνώµων» 

2.1 Εισαγωγικά 
Το λογισµικό «Υδρογνώµων» είναι µία εφαρµογή για την διαχείριση και την επεξεργασία 
των υδρολογικών δεδοµένων που περιέχονται στην Βάση ∆εδοµένων. Συγκεκριµένα το 
λογισµικό «Υδρογνώµων» µπορεί να διαχειριστεί: 

��Χρονοσειρές όπως βροχόπτωση, εξάτµιση, θερµοκρασία, σχετική υγρασία, στάθµη 
ταµιευτήρα, απορροή λεκάνης, παροχή υδατορεύµατος κ.α. 

��Γεωγραφικά δεδοµένα ως «οντότητες πραγµατικού κόσµου» ή απλούστερα «γεωγραφικές 
οντότητες» όπως πόλεις (cities), ταµιευτήρες (reservoirs), φράγµατα (dams), 
µετεωρολογικούς (µετρητικούς εν γένει) σταθµούς (stations) κ.α. 

��Σταθερές υπολογισµών που συσχετίζονται µε οντότητες του πραγµατικού κόσµου όπως 
καµπύλες στάθµης - παροχής υδατορεύµατος, καµπύλες στάθµης - αποθέµατος 
ταµιευτήρα κ.α. 

Επιπλέον, το λογισµικό «Υδρογνώµων» έχει την δυνατότητα εκτέλεσης απλών επεξεργασιών 
όπως στατιστική συσχέτιση χρονοσειρών (γραµµική παλινδρόµηση), συνάθροιση 
χρονοσειρών, υπολογισµός παροχής από στάθµη, υπολογισµός ύψους εξάτµισης, ισοζύγια 
ταµιευτήρων κ.α. 

2.2 Υλοποίηση - Εµφάνιση 
Το λογισµικό «Υδρογνώµων» αποτελείται από τρεις κύριους τοµείς: 

��Το σύστηµα επικοινωνίας µε την βάση δεδοµένων 
��Το τµήµα επεξεργασίας των δεδοµένων 
��Το γραφικό περιβάλλον επικοινωνίας µε τον χρήστη 

Το γραφικό περιβάλλον επικοινωνίας υλοποιείται µε φόρµες (παράθυρα), µε την βοήθεια των 
οποίων είναι δυνατή η άντληση δεδοµένων από την βάση δεδοµένων, η επεξεργασία των 
δεδοµένα και η ενηµέρωση της βάσης δεδοµένων αποθηκεύοντας τυχόν αλλαγές ή εισαγωγή 
νέων δεδοµένων. 

Οι κύριες φόρµες του λογισµικού «Υδρογνώµων», είναι οι παρακάτω: 

��Φόρµες για την διαχείριση γεωγραφικών οντοτήτων (τα καλούνται και “Gentities”), όπως 
ταµιευτήρες, µετρητικοί σταθµοί, πόλεις, λεκάνες, κ.α. 

��Φόρµες για την διαχείριση χρονοσειρών (Time series) και των δεδοµένων των 
χρονοσειρών. 

Επιπλέον το λογισµικό «Υδρογνώµων» περιέχει βοηθητικές φόρµες υπολογισµών (π.χ. για 
την συνάθροιση χρονοσειρών, για τον υπολογισµό στάθµης-παροχής, υπολογισµό ισοζυγίου 
ταµιευτήρα, κ.α.). Επιπλέον, βοηθητικές φόρµες για τις ρυθµίσεις του λογισµικού 
«Υδρογνώµων», την σύνδεση µε την βάση δεδοµένων κ.α. 
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Οι βοηθητικές φόρµες αποτελούν επιµέρους λειτουργίες που ανοίγουν από τις κύριες φόρµες, 
επιπλέον κάποιες βοηθητικές φόρµες µπορούν να ανοίξουν από όλες τις κύριες φόρµες, όπως 
οι «ρυθµίσεις». 

2.3 Tools, Ρυθµίσεις, σύνδεση µε την Βάση ∆εδοµένων 
Οι ρυθµίσεις - εργαλεία (Tools) είναι ένα menu που περιέχεται σε όλες τις φόρµες του 
λογισµικού «Υδρογνώµων». Πέρα από τις βασικές λειτουργίες του µενού “Tools” που θα 
αναφερθούν στην συνέχεια, εισάγονται εξειδικευµένες λειτουργίες που αφορούν 
συγκεκριµένες φόρµες (όπως η συνάθροιση των χρονοσειρών - aggregate - κάτι που 
εµφανίζεται µόνο στο µενού Tools της φόρµας των χρονοσειρών). Το µενού Tools 
απεικονίζεται στην συνέχεια: 

 
Σχήµα 2.1: Το µενού Tools των εφαρµογών του λογισµικού «Υδρογνώµων». 

 
Με την επιλογή “Connect to database” πραγµατοποιείται η σύνδεση του λογισµικού 
«Υδρογνώµων» µε την βάση δεδοµένων. Η χρήση αυτής της επιλογής είναι δυνατή µόνο 
εφόσον δεν έχει πραγµατοποιηθεί σύνδεση µε την βάση κατά την εκκίνηση του λογισµικού 
«Υδρογνώµων». 

Προκειµένου να πραγµατοποιηθεί η σύνδεση, πρέπει να εισαχθεί στο σύστηµα το όνοµα 
σύµφωνα µε το οποίο κάνουµε ταυτοποίηση (username) καθώς και την συνθηµατική λέξη  
(password). Επιπλέον πρέπει να εισαχθεί το όνοµα της βάσης δεδοµένων (πεδίο Database). Η 
εισαγωγή γίνεται χρησιµοποιώντας την παρακάτω φόρµα: 

 
Σχήµα 2.2: Η φόρµα σύνδεσης στην βάση δεδοµένων. 

 
Η αλλαγή του password που χρησιµοποιείται για την ταυτοποίηση στην βάση δεδοµένων 
είναι δυνατή µε την χρήση της επιλογής “Change Database Password” του menu “Tools” του 
λογισµικού «Υδρογνώµων». Τότε, ενεργοποιείται το παρακάτω παράθυρο µε την βοήθεια του 
οποίου αλλάζουµε το password: 

 
Σχήµα 2.3: Αλλαγή κωδικής λέξης (password) της βάσης δεδοµένων. 
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Χρησιµοποιώντας την επιλογή του menu: “Tools - Options” είναι δυνατή η τροποποίηση 
κάποιων από τις βασικές ρυθµίσεις του λογισµικού «Υδρογνώµων»: 

 
Σχήµα 2.4: Βασικές ρυθµίσεις του λογισµικού «Υδρογνώµων». 

 
Οι βασικές ρυθµίσεις αφορούν: 

Τις φόρµες που απεικονίζονται κάθε φορά που γίνεται εκκίνηση του λογισµικού 
«Υδρογνώµων» (Windows to show at startup), π.χ. Φόρµα σταθµών (stations), ταµιευτήρων 
(reservoirs), χρονοσειρών (Time series) κλπ 

Την σύνδεση του λογισµικού «Υδρογνώµων» µε την βάση δεδοµένων κατά την εκκίνηση 
(Connect to database at application startup) 

2.4 Σύνδεση του λογισµικού «Υδρογνώµων» µε την Βάση ∆εδοµένων 
Η πλήρη λειτουργικότητα του λογισµικού «Υδρογνώµων» επιτυγχάνεται όταν έχει 
αποκατασταθεί επικοινωνία του λογισµικού µε την Βάση ∆εδοµένων. Η αποκατάσταση 
γίνεται µε δύο τρόπους: 

��Κατά την εκκίνηση, όταν στις επιλογές (options) έχουµε καθορίσει να γίνεται σύνδεση 
κατά την εκκίνηση 

��Οποιαδήποτε στιγµή, χρησιµοποιώντας το menu “Connect to Database” από το κύριο 
menu “Tools”. 

Η επαλήθευση των στοιχείων του χρήστη καθώς και η επιλογή της ονοµασίας της βάσης (η 
ονοµασία της βάσης γνωστοποιείται από τον διαχειριστή της Βάσης ∆εδοµένων), γίνεται 
χρησιµοποιώντας το παρακάτω παράθυρο: 

 
Σχήµα 2.5: Σύνδεση µε την βάση δεδοµένων. 

 
Αφού γίνει επιτυχής σύνδεση µε την Βάση ∆εδοµένων, είναι δυνατή στην συνέχεια η χρήση 
οποιασδήποτε φόρµας του λογισµικού «Υδρογνώµων». 

Όταν το λογισµικό «Υδρογνώµων» για κάποιο λόγο δεν επικοινωνεί µε την βάση δεδοµένων 
(είτε λόγω κάποιου τεχνικού προβλήµατος είτε κατόπιν απαίτησης του χρήστη), οι 
δυνατότητες του λογισµικού περιορίζονται στην εµφάνιση της φόρµας των δεδοµένων των 
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χρονοσειρών. Σε αυτήν την κατάσταση είναι δυνατή η ανάκτηση ή η εγγραφή των 
χρονοσειρών από /σε αρχεία κειµένου (Text Files) και φυσικά όχι από την βάση δεδοµένων. 

 

2.5 Windows Menu 
Όλες οι κύριες φόρµες του λογισµικού «Υδρογνώµων» περιέχουν το menu: “Windows” το 
οποίο απεικονίζεται στην συνέχεια: 

 
Σχήµα 2.6: Το Menu: “Windows” 

 
Μέσω αυτού του menu µπορούµε να ενεργοποιήσουµε οποιαδήποτε φόρµα του λογισµικού 
«Υδρογνώµων», από αυτές για την διαχείριση των οντοτήτων (Stations - Σταθµοί, Reservoirs 
- Ταµιευτήρες, Dams - Φράγµατα, Cities - Πόλεις, Aqueducts - Υδραγωγεία, Boreholes - 
Γεωτρήσεις, Pump generators - Γεννήτριες, αντλίες, Treatment plants - ∆ιυλιστήρια, Basins - 
Λεκάνες απορροής), επεξεργασίας δεδοµένων των χρονοσειρών (Time series data), προβολής 
των χρονοσειρών του συστήµατος της βάσης (Full time series list). Τέλος ο διαχειριστής της 
βάσης δεδοµένων έχει πρόσβαση στο menu: “Lookup tables” όπου µπορεί να ενηµερώσει 
ειδικούς πίνακες αντιστοίχισης της βάσης (όπως µονάδες µέτρησης κ.α.). 
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3 Επεξεργασία δεδοµένων των χρονοσειρών 

3.1 Γενικά 
Με χρήση του λογισµικού «Υδρογνώµων» είναι δυνατή: η διαχείριση των χρονοσειρών, η 
επέµβαση και η επεξεργασία στα τα δεδοµένα τους, η αποθήκευση στην βάση δεδοµένων ή 
σε εξωτερικά αρχεία καθώς και η διενέργεια απλών υπολογισµών. Τα παραπάνω 
πραγµατοποιούνται χρησιµοποιώντας την φόρµα επεξεργασίας χρονοσειρών (Timeseries 
data). Η φόρµα απεικονίζεται στο παρακάτω σχήµα: 

 
Σχήµα 3.1: Η φόρµα “Time series data” για την επεξεργασία των δεδοµένων των 

χρονοσειρών. 
 
��Η Φόρµα µπορεί να χωριστεί στα παρακάτω τµήµατα: 
��Μία µπάρα του κύριου µενού (Menu) µε τις επιλογές: Series, Edit, View, Tools, Graph, 

Windows, Help 
��Μία µπάρα µε κουµπιά (Buttons) που αναπαράγουν βασικές λειτουργίες των menu: From 

DB/ To DB, From File/ To file, Close, Filter, Previous - Next, Table, Graph 
��Τον πίνακα όπου απεικονίζονται τα δεδοµένα των χρονοσειρών (Data Grid) σε µορφή 

στηλών ή πίνακα 
��Μία µπάρα κατάστασης (status bar), στο κάτω µέρος της φόρµας όπου αναπαράγονται 

µηνύµατα του λογισµικού «Υδρογνώµων» 

 

3.2 Επιλογές (Menu) φόρµας Timeseries data 
Οι επιλογές της φόρµας Timeseries data µέσω menu είναι οι παρακάτω: 
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Σχήµα 3.1: Ανώτερη ιεραρχία Menu: “Series”, “Edit”, “View”, “Tools”, “Graph”, “Window” 

και “Help”. 
 

3.2.1 Menu: Series 

 
Σχήµα 3.2: Περιεχόµενα του Menu: “Series”. 

 
New: ∆ηµιουργείται µία νέα χρονοσειρά και απεικονίζεται στον πίνακα των χρονοσειρών 
(Timeseries grid) ως στήλη. Η χρονοσειρά που θα δηµιουργηθεί είναι κενή (δεν θα περιέχει 
καµία εγγραφή). 

Load from database: Φορτώνεται µία χρονοσειρά από την βάση δεδοµένων. Πρέπει να δώθεί 
το ID της χρονοσειράς καθώς και το χρονικό διάστηµα για το οποίο θα αντληθούν δεδοµένα. 

Write to database: Η χρονοσειρά που είναι επιλεγµένη στον πίνακα απεικόνισης χρονοσειρών 
(η ενεργή χρονοσειρά), αποθηκεύεται στην Βάση ∆εδοµένων σε υπάρχουσα καταχώρηση µε 
συγκεκριµένο ID. 

Load from file / Write to file: Ανάκτηση / αποθήκευση χρονοσειράς από / σε αρχείο κειµένου 
(Text file). 

Properties: Εµφάνιση / τροποποίηση ιδιοτήτων της ενεργής χρονοσειράς. Οι ιδιότητες προς 
τροποποίηση είναι οι αυτές που εισάγονται κατά την δηµιουργία µίας νέας χρονοσειράς. 

Close time series: Απόκρυψη (κλείσιµο - αποφόρτιση) της ενεργής χρονοσειράς που 
εµφανίζεται στον πίνακα (Timeseries grid). 

Close window: Απόκρυψη του τρέχοντος παραθύρου (Timeseries data). Αν δεν είναι ανοιχτή 
κάποια άλλη κύρια φόρµα του λογισµικού «Υδρογνώµων», το λογισµικό θα σταµατήσει να 
εκτελείται. 
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3.2.2 Menu: Edit 

 
Σχήµα 3.3: Περιεχόµενα του Menu: Edit. 

 
Copy / Copy with dates / Paste: τυπικές λειτουργίες των προγραµµάτων windows. Είναι 
δυνατή η αντιγραφή δεδοµένων από το λογισµικό «Υδρογνώµων» προς άλλες εφαρµογές των 
windows (π.χ. Notepad, Microsoft Word, Microsoft Excel) ή ακόµα και να αντιστραφεί η 
φορά εισάγοντας εξωτερικά δεδοµένα. Επιπλέον µπορούµε να αντιγράψουµε δεδοµένα των 
χρονοσειρών µεταξύ διαφορετικών στηλών της φόρµας. Με τον τρόπο αυτόν αντιγράφουµε 
αριθµητικές τιµές από κάποια χρονοσειρά σε κάποια άλλη (σε υπάρχουσες εγγραφές µε 
καθορισµένες ηµεροµηνίες) ή δεδοµένα µε τις ηµεροµηνίες τους µεταξύ των διαφορετικών 
στηλών. 

Paste monthly table: Η λειτουργία αυτή επιτρέπει την αντιγραφή από άλλες εφαρµογές των 
windows (τυπικά από το MS Excel), τιµών µίας χρονοσειράς που είναι διατεταγµένες σε 
πίνακα 12 στηλών και n γραµµών. Οι 12 στήλες αναπαριστούν τους 12 µήνες του χρόνου ενώ 
οι n γραµµές είναι τα έτη. Εάν επιχειρηθεί η αντιγραφή πίνακα µε αριθµό στηλών διάφορο 
του 12 θα παρουσιαστεί µήνυµα σφάλµατος και θα σταµατήσει η λειτουργία. Αν τα δεδοµένα 
είναι ορθώς διατεταγµένα σε 12 στήλες, θα ζητηθεί να εισαχθεί το έτος όπου θα αρχίσει η 
αντιγραφή των δεδοµένων καθώς και αν χρησιµοποιείτε υδρολογικό έτος (µε αρχή την 1η 
Οκτωβρίου) ή ηµερολογιακό έτος (µε αρχή την πρώτη Ιανουαρίου). Στην πρώτη περίπτωση, 
η πρώτη στήλη θα περιέχει τις τιµές του Οκτωβρίου ενώ στην δεύτερη τις τιµές του 
Ιανουαρίου. 

Insert record: ∆ηµιουργείται µία νέα (κενή) εγγραφή στην ενεργή χρονοσειρά καθορίζοντας 
την ηµεροµηνία αυτής της εγγραφής. Ο ορθός τρόπος εισαγωγής της ηµεροµηνίας είναι: 
EEEE/MM/HH ΩΩ:ΛΛ. 

Insert multi records: Μας επιτρέπει την εισαγωγή πολλών, κενών εγγραφών. Η εκτέλεση της 
εντολής είναι δυνατή εφόσον υπάρχει τουλάχιστον µία εγγραφή στην χρονοσειρά. Θα ζητηθεί 
η εισαγωγή του πλήθους των νέων κενών εγγραφών. Οι κενές εγγραφές εισάγονται στο τέλος 
της χρονοσειράς σύµφωνα µε το χρονικό βήµα (το οποίο πρέπει να είναι από δεκάλεπτο έως 
ετήσιο. Ακανόνιστο ή άγνωστο χρονικό βήµα δεν είναι αποδεκτό και σε αυτήν την περίπτωση 
δεν επιτρέπεται η εισαγωγή). 
Delete selected records: Μέσω αυτής της λειτουργίας, διαγράφονται οι εγγραφές που έχουν 
επιλεγεί στον πίνακα απεικόνισης των χρονοσειρών. Οι εγγραφές που δεν εµφανίζονται π.χ. 
λόγω της χρήσης κάποιου φίλτρου παραµένουν αµετάβλητες. 

Select entire time series: Γίνεται επιλογή όλων των εγγραφών της ενεργής χρονοσειράς. 
(Ενεργοποίηση και µε τον συνδυασµό πλήκτρων Ctrl+A). 

Set Value: Αλλαγή της αριθµητικής τιµής κάποιας εγγραφής ή πλήθους εγγραφών. Αυτό 
γίνεται εναλλακτικά, πατώντας σε κάποια εγγραφή και γράφοντας απευθείας την νέα τιµή. 
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Set Flags: Ενεργοποιούνται «σηµαίες» για συγκεκριµένη εγγραφή της χρονοσειράς ή κάποια 
πολλαπλή επιλογή εγγραφών. Συγκεκριµένα µπορούµε να θέσουµε τις σηµαίες µε δυαδικό 
χαρακτήρα εντός (on) ή εκτός (off). Οι σηµαίες µε τριαδικό χαρακτήρα (0,1,2) όπως η 
σηµαία Range θέτονται ορθώς από τα εργαλεία “Range check” και “Consistency check”. 

3.2.3 Menu: View 

 
Σχήµα 3.4: Περιεχόµενα του Menu: View. 

 
As Table: Είναι δυνατή η απεικόνιση της χρονοσειράς µε την µορφή πίνακα µορφή ως εξής: 
Αν το βήµα της χρονοσειράς είναι π.χ. µηνιαίο, οι γραµµές αναπαριστούν τα έτη ενώ οι 
στήλες τους µήνες. Έτσι είναι δυνατή η εµφάνιση της µεταβολής ανά έτος για κάθε µήνα 
χωριστά. Αντίστοιχα γίνεται η εµφάνιση για χρονοσειρές µικρότερου χρονικού βήµατος. Με 
παρόµοιο τρόπο απεικονίζονται ωριαίες και ηµερήσιες χρονοσειρές. 

Hydrological year: Η επιλογή αυτή µπορεί να ενεργοποιηθεί όταν η χρονοσειρά 
απεικονίζεται ως πίνακας (As Table). Όταν είναι ενεργοποιηµένη, η αρχή του έτους θεωρείται 
η αρχή του υδρολογικού έτους (1η Οκτωβρίου) αντί της αρχής του ηµερολογιακού έτους (1 
Ιανουαρίου). 

Show Statistics: Η επιλογή αυτή µπορεί να ενεργοποιηθεί όταν η χρονοσειρά απεικονίζεται 
ως πίνακας. Όταν είναι ενεργοποιηµένη, εµφανίζονται σε επιπλέον στήλη /γραµµή στατιστικά 
για την χρονοσειρά. 

Show flags: Ενεργοποιείται εµφάνιση των σηµαιών σε νέα στήλη, δίπλα στην στήλη της 
χρονοσειράς. 

Highlight mode: Μέθοδοι για την γραφική ανάδειξη εγγραφών των χρονοσειρών βάσει 
κριτηρίων. 

Set filter/Filter: Είναι δυνατή η απόκρυψη / εµφάνιση εγγραφών των χρονοσειρών σύµφωνα 
µε κάποιο «φίλτρο» (π.χ. τιµές µεγαλύτερες /µικρότερες από κάποια τιµή). 
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3.2.4 Menu: Tools 

 
Σχήµα 3.5: Περιεχόµενα του Menu: Tools 

 
Οι επιλογές του menu “Tools”: “Connect to database”, “change database password” και 
“Options” είναι κοινές για όλες τις φόρµες του λογισµικού «Υδρογνώµων». Στην φόρµα 
επεξεργασίας των χρονοσειρών (Time series data), παρέχονται επιπλέον οι εξής επιλογές: 

Range check: Ελέγχονται οι τιµές των εγγραφών των χρονοσειρών αν βρίσκονται µεταξύ 
κάποιων ορίων. Αν όχι, ανάβει κάποιο σηµαιάκι. Αν το σηµαιάκι είναι τριαδικού χαρακτήρα 
τίθεται «2» ως αληθής τιµή, «1» αν έχει γίνει έλεγχος και η τιµή είναι ψευδής ενώ τιµή «0» 
παραµένει αν δεν έχει γίνει έλεγχος. 

Time consistency check: Γίνεται έλεγχος της χρονικής συνέπειας µίας χρονοσειράς. Εισάγεται 
η µέγιστη απόκλιση ή κατώφλι (trigger) που µπορούν να έχουν δύο διαδοχικές τιµές της 
χρονοσειράς, αν γίνει υπέρβαση της τιµής αυτής, σηκώνεται σηµαία. 

Regularize step: Αναίρεση τυχόν χρονικών µετατοπίσεων (σε µία λέξη: κανονικοποίηση), 
επιβολή χρονικών διαστηµάτων σύµφωνα µε το βήµα της χρονοσειράς. Μετά το πέρας αυτής 
της επεξεργασίας, η χρονοσειρά αποκτά «αυστηρό» χρονικό βήµα (time step strict). 

Aggregation: Λειτουργίες συνάθροισης - εξαγωγής χρονοσειράς µεγαλύτερου χρονικού 
βήµατος. π.χ. συνολικά αθροίσµατα, µέσες τιµές. Το νέο χρονικό βήµα µετά την συνάθροιση 
θα είναι µίας τάξης µεγέθους µεγαλύτερο σύµφωνα µε την σειρά: δεκάλεπτο→ ωριαίο→ 
ηµερήσιο→ µηνιαίο→ ετήσιο. 

Regression: Συσχέτιση (γραµµική παλινδρόµηση) µεταξύ δύο χρονοσειρών ή πολλαπλή 
συσχέτιση µεταξύ περισσότερων χρονοσειρών. 

Evaporation: Ανοίγει φόρµα για τον υπολογισµό τους ύψους εξάτµισης (βλ. Κεφάλαιο 4). 

Linear Combination: Ανοίγει φόρµα για την εκτέλεση γραµµικών πράξεων µεταξύ 
χρονοσειρών. 

Interpolations: Ανοίγει φόρµα για την εκτέλεση παρεµβολών χρονοσειρών σε καµπύλες (π.χ. 
υπολογισµός στάθµης-παροχής - βλ. Κεφάλαιο 5). 
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3.2.5 Menu: Graph 

 
Σχήµα 3.6: Περιεχόµενα του Menu: Graph. 

 
Add Timeseries to graph: Κατασκευάζει ένα νέο γράφηµα εφόσον δεν υπάρχει ήδη. 
Προστίθενται οι χρονοσειρές που έχετε επιλέξει από το grid. Κάθε χρονοσειρά απεικονίζεται 
µε διαφορετικό χρώµα. 

Remove Timeseries from graph: Μπορούµε να αφαιρέσουµε µία ή περισσότερες χρονοσειρές 
που έχουν ήδη σχεδιαστεί στο γράφηµα. Οι χρονοσειρές του γραφήµατος αφαιρούνται και 
όταν «κλείσουµε» (close) κάποια χρονοσειρά από το grid. 

Clear Graph: «Καθαρίζει» τα γραφήµατα από το παράθυρο γραφηµάτων. 

Allow Different Units: Επιτρέπεται να σχεδιαστούν χρονοσειρές διαφορετικών µονάδων. 

3.2.6 Menu: Windows 

 
Σχήµα 3.7: Περιεχόµενα του Menu: Window. 

 
Το menu windows είναι κοινό σε όλες τις φόρµες του λογισµικού «Υδρογνώµων». Μέσω του 
µενού είναι δυνατή η ενεργοποίηση των υπολοίπων φορµών του λογισµικού «Υδρογνώµων». 

3.3 Κουµπιά (Buttons) της φόρµας επεξεργασίας χρονοσειρών (Time 
series data) 

Τα κουµπιά λειτουργιών του λογισµικού «Υδρογνώµων», αναπαράγουν λειτουργίες βασικών 
menu. Είναι διατεταγµένα σε µία µπάρα η οποία φαίνεται στο παρακάτω σχήµα: 

 
Σχήµα 3.8: Κουµπιά της φόρµας επεξεργασίας χρονοσειρών. 

 
From db / To db: Ανάκτηση / αποθήκευση χρονοσειρών από / στην βάση δεδοµένων. 

From file / To file : Ανάκτηση / αποθήκευση χρονοσειρών από / στην βάση δεδοµένων. 
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Close: Απόκρυψη της ενεργής χρονοσειράς. 

Filter: Απόκρυψη εγγραφών της χρονοσειράς σύµφωνα µε κριτήρια. 

Previous / Next: ∆είχνει τον επόµενο /προηγούµενο µήνα ή έτος όταν η χρονοσειρά 
απεικονίζεται µε την µορφή πίνακα. 

Table: Απεικόνιση της χρονοσειράς µε την µορφή πίνακα. 

Graph: Σχεδίαση γραφηµάτων των επιλεγµένων χρονοσειρών. 

3.4 Ενεργή χρονοσειρά (active time series) 
Ως ενεργή χρονοσειρά θεωρείται αυτή στην οποία έχουµε «δείξει» είτε µε πάτηµα του 
ποντικιού σε κάποια εγγραφή, είτε µε οποιοδήποτε τρόπο φαίνεται να έχει επιλεγεί κάποια 
εγγραφή συγκεκριµένης χρονοσειράς. Στο παρακάτω Σχήµα - παράδειγµα, η χρονοσειρά 62 
είναι η ενεργή χρονοσειρά: 

 
Σχήµα 3.9: Ορισµός «ενεργής χρονοσειράς». 

 

3.5 Ανάκτηση χρονοσειράς (φόρτωση, loading) 
Οι χρονοσειρές που είναι αποθηκευµένες στην βάση δεδοµένων είναι υποχρεωτικά 
συσχετισµένες µε κάποια γεωγραφική οντότητα (gentity) όπως ταµιευτήρες, µετρητικοί 
σταθµοί, κ.α. 

Η ανάκτηση µίας χρονοσειράς µπορεί να γίνει µε τρεις διαφορετικούς τρόπους: 

��Μέσω της φόρµας Timeseries (βλ. Παράγραφο 3.6) η οποία καλείται από φόρµες 
γεωγραφικών οντοτήτων και µε την βοήθεια της οποίας είναι δυνατή η διαχείριση των 
χρονοσειρών αυτής της οντότητας (π.χ. δηµιουργία νέας χρονοσειρά, διαγραφή κ.α.). 
Επιπλέον χρησιµοποιώντας το κοινό στοιχείο των µενού του λογισµικού «Υδρογνώµων»: 
Window→ Full time series list. 

��Με την λειτουργία “Load from db” της φόρµας “Time series data” είναι δυνατή η 
ανάκτηση µίας χρονοσειράς εισάγοντας τον αριθµό ID. 

��Με την λειτουργία “Load from file” της φόρµας “Time series data”, είναι δυνατή η 
ανάκτηση χρονοσειράς από αρχείο κειµένου όπου περιέχει εγγραφές. 

3.6 Φόρµα “Timeseries” 
Οι χρονοσειρές που είναι αποθηκευµένες στην βάση δεδοµένων είναι υποχρεωτικά 
συσχετισµένες µε κάποια γεωγραφική οντότητα (gentity). Σε κάθε φόρµα gentity όπως στην 
φόρµα ταµιευτήρων, µετρητικών σταθµών κλπ, υπάρχει ένα κουµπί το οποίο ενεργοποιεί την 
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φόρµα Timeseries. Στο παρακάτω σχήµα απεικονίζεται η φόρµα ενός ταµιευτήρα καθώς και 
το κουµπί “Timeseries”: 

 
Σχήµα 3.10: Φόρµα ταµιευτήρων (τυπική φόρµα τύπου “Gentities”). Κουµπί “Time series”. 

 
Αφού πιεστεί το κουµπί “Timeseries” θα ανοίξει η φόρµα Timeseries που απεικονίζεται 
παρακάτω: 

 
Σχήµα 3.11: Φόρµα διαχείρισης χρονοσειρών: “Time series”. 

 
Η πρόσβαση στην φόρµα των χρονοσειρών µπορεί να γίνει και από το µενού όλων των 
φορµών του λογισµικού «Υδρογνώµων»: Window→ Full time series list, καθιστώντας 
δυνατή την πρόσβαση (µόνο για επισκόπηση στοιχείων, όχι για τροποποίηση ή προσθήκη 
χρονοσειράς) σε όλες τις χρονοσειρές της βάσης δεδοµένων. 

Τα πεδία που είναι «γκριζαρισµένα» (απενεργοποιηµένα) απεικονίζουν τιµές που δεν 
µπορούν να µεταβληθούν. 

Τα πεδία που έχουν µαύρο χρώµα είναι ενεργά και επιτρέπεται η επέµβαση (Type - τύπος 
χρονοσειράς, Variable - µεταβλητή, Unit - µονάδα µέτρησης, Precision - ακρίβεια σε 
δεκαδικά ψηφία, Name - ονοµασία χρονοσειράς, Step - χρονικό βήµα, Offset - χρονική 
µετατόπιση ως προς τις κύριες χρονικές κατατµήσεις). 

Χρησιµοποιώντας τα κουµπιά: |< < > >| + - ∆ ν X C εκτελούνται οι παρακάτω λειτουργίες: 



      25

|< < > >| Με αυτά τα κουµπιά γίνεται η µετακίνηση (πλοήγηση) ανάµεσα στις εγγραφές 
(χρονοσειρές) της βάσης δεδοµένων (πρώτη, προηγούµενη, επόµενη, τελευταία εγγραφή). 

+ Προστίθεται µία νέα εγγραφή (χρονοσειρά) που θα είναι συσχετισµένη µε την τρέχουσα 
γεωγραφική οντότητα. 

- ∆ιαγράφεται από την βάση δεδοµένων η χρονοσειρά που απεικονίζεται. 

∆ Καθιστά δυνατή την τροποποίηση των δεδοµένων της χρονοσειράς (editing). 

ν Γίνεται η αποδοχή - αποθήκευση των αλλαγών που έχουν γίνεται στα πεδία, στην βάση 
δεδοµένων. 

X Ακύρωση των αλλαγών που έχουν γ στα πεδία 

C Γίνεται ανανέωση των πεδίων που απεικονίζονται (refresh) 

Για να δοθεί µία συνολική εικόνα για τις χρονοσειρές της γεωγραφικής οντότητας 
χρησιµοποιείται ο συνοπτικός πίνακας ο οποίός εµφανίζεται όταν πατηθεί ο σελιδοδείκτης 
(καρτέλα) “Synoptic table”. Με µονό ή διπλό κλικ µπορούµε να επεξεργαστούµε κάποια 
χρονοσειρά από τον συνοπτικό πίνακα (το διπλό κλικ επιπλέον επιστρέφει στην αρχική 
σελίδα). Ο συνοπτικός πίνακας µπορεί να αντιγραφεί σε κάποια άλλη εφαρµογή (π.χ. MS 
Excel) µέσω του µενού Εdit→ Copy synoptic table. Επιπλέον, υπάρχει η δυνατότητα να 
«φιλτράρονται» οι χρονοσειρές που απεικονίζονται µε το κριτήριο: [Απεικόνιση των 
πραγµατικών ή των συνθετικών ή όλων των χρονοσειρών] (µέσω του Menu: Edit→ Show...). 
Στο παρακάτω σχήµα απεικονίζονται συνοπτικά οι χρονοσειρές του ταµιευτήρα «Μόρνος»: 

 
Σχήµα 3.12: Συνοπτικός πίνακας χρονοσειρών 

 
Για να ανακτηθεί η χρονοσειρά στην φόρµα “Time series data”, πατάµε το κουµπί “Data”. 
Στο σηµείο αυτό εµφανίζεται µία νέα φόρµα που προτρέπει την ανάκτηση της χρονοσειράς 
αντλώντας εγγραφές από συγκεκριµένο χρονικό διάστηµα όπου µπορείτε να ορίσετε 
προαιρετικά. 

Χρησιµοποιώντας το κουµπί “Graph” είναι δυνατή η προεπισκόπηση της χρονοσειράς µε την 
µορφή γραφήµατος (βλέπε και Παράγραφο 3.18). 

3.7 Επιλογή “Series - New” της φόρµας “Time series data” 
Η επιλογή αυτή ενεργοποιείται µέσω του αντίστοιχου µενού της φόρµας “Time series data”. 
Ενεργοποιώντας την επιλογή εµφανίζεται το παρακάτω παράθυρο: 
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Σχήµα 3.13: Φόρµα κατά την δηµιουργία νέας χρονοσειράς. 

 
Πριν δηµιουργηθεί η νέα (κενή) χρονοσειρά πρέπει να καθοριστεί µέσω της παραπάνω 
φόρµας: το χρονικό βήµα (Time step), η χρονική απόκλιση από τις κατατµήσεις του χρόνου 
(Date offset), ο τύπος της µεταβλητής (Variable type), η µονάδα µέτρησης (Unit: περιγραφικό 
πεδίο), Τίτλος χρονοσειράς (Display title), τυχόν σχόλια (Display comment) καθώς και η 
αριθµητική ακρίβεια σε αριθµό δεκαδικών ψηφίων (Precision). 

ΠΡΟΣΟΧΗ: Η δηµιουργία της νέας χρονοσειράς µε αυτόν τον τρόπο, αφορά την δηµιουργία 
µίας νέας στήλης στην φόρµα “Time series data” και όχι εγγραφής στην βάση δεδοµένων. 
Εάν παρόλα αυτά είναι επιθυµητή η δηµιουργία µίας νέας χρονοσειράς που θα αποθηκευτεί 
στην βάση δεδοµένων πρέπει να εκτελεστεί µία από τις παρακάτω δύο ενέργειας: 

�� Είτε η δηµιουργία µία νέας χρονοσειράς συσχετισµένη µε γεωγραφική οντότητα µέσω της 
φόρµας “Time series” και του κουµπιού “+”, και έπειτα η ανάκτησή της για επεξεργασία 
πατώντας το κουµπί “Data” 

�� Είτε ακολουθώντας την προηγούµενη διαδικασία και έχοντας σηµειώσει το ID της νέας 
χρονοσειράς, σε διαφορετική χρονική στιγµή θα δηµιουργηθεί µία νέα χρονοσειρά στην 
φόρµα “Time series grid”, θα πληρωθεί ενδεχοµένως µε εγγραφές και θα αποθηκευτεί 
τελικά στο νέο ID µέσω της λειτουργίες “Write to db”. 

3.7.1 Χρονικό Βήµα 
Οι εγγραφές των χρονοσειρών που αναφέρονται σε στιγµιαία δεδοµένα (instant) 
αποθηκεύουν τιµές που αναφέρονται στην χρονική στιγµή των εγγραφών. Ωστόσο στις 
χρονοσειρές που αναφέρονται σε κάποιο χρονικό διάστηµα (όπως χρονοσειρές µεγίστων / 
ελαχίστων, µέσων τιµών, αθροισµάτων) γίνεται η εξής διάκριση: 

��Στις χρονοσειρές µε χρονικό βήµα δεκάλεπτο, ωριαίο ή ηµερήσιο, οι τιµές που 
αποθηκεύονται στην χρονική στιγµή της εγγραφής αναφέρονται στο χρονικό διάστηµα 
που προηγείται. Για παράδειγµα η µέση θερµοκρασία την 2003/11/05 08:00 αναφέρεται 
στο µέσο όρο των θερµοκρασιών από 2003/11/04 08:00:01 έως 2003/11/05 08:00:00. 

��Στις χρονοσειρές µε χρονικό βήµα µηνιαίο ή ετήσιο, οι τιµές που αναφέρονται στο 
συγκεκριµένο µήνα ή έτος, οι χρονικές στιγµές αποθήκευσης είναι η αρχή του χρονικού 
διαστήµατος. Έτσι για παράδειγµα, η συνολική βροχόπτωση του Νοεµβρίου 2003 
αποθηκεύεται στην χρονική στιγµή 2003/11/01 00:00. 

3.7.2 Αυστηρό χρονικό βήµα - χρονική µετατόπιση 
Οι µηνιαίες και οι ετήσιες χρονοσειρές έχουν αυστηρό χρονικό βήµα εξ’ ορισµού. Όσον 
αφορά τις ηµερήσιες, ωριαίες ή δεκάλεπτες, έχουν την δυνατότητα να είναι αυστηρού 
χρονικού βήµατος. Σε αυτήν την περίπτωση πρέπει να καθοριστεί η χρονική µετατόπιση (date 
offset) από τις κύριες υποδιαιρέσεις των χρονικών διαστηµάτων. Η χρονική µετατόπιση είναι 
απαραίτητη για να εκτελεστούν στην συνέχεια κάποιες επεξεργασίες. Για παράδειγµα, στην 
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περίπτωση ηµερήσιας χρονοσειράς αυστηρού χρονικού βήµατος, όπου οι τιµές αναφέρονται 
στις 08:00 π.µ. κάθε µέρα, η χρονική µετατόπιση από την κύρια υποδιαίρεση της ηµέρας 
(όπου είναι η 00:00) είναι 480 λεπτά. 
Κάθε χρονοσειρά µπορεί να αποκτήσει αυστηρό χρονικό βήµα εφόσον υποστεί την 
επεξεργασία “Regularize step” (βλ. Παράγραφο 3.14), συνιστάται µάλιστα να µην ορίζεται 
εξ΄ αρχής από τον χρήστη το αυστηρό χρονικό βήµα πριν γίνει η παραπάνω επεξεργασία. 

3.8 Επιλογή “Series - Properties” 
Ανά πάσα στιγµή, είναι δυνατή η επισκόπηση των ιδιοτήτων κάποιας χρονοσειράς που 
απεικονίζεται στην φόρµα “Time series data”. Με την επιλογή (µενού) “Series - Properties” 
της φόρµας εµφανίζεται το παρακάτω παράθυρο: 

 
Σχήµα 3.14: Φόρµα τροποποίησης των ιδιοτήτων της χρονοσειράς. 

 
Η επισκόπηση των ιδιοτήτων µπορεί να γίνει µε απλή υπέρθεση του δείκτη του ποντικιού 
(mouse pointer) στην στήλη της χρονοσειράς, στο (γκρίζο) κελί όπου αναφέρεται ο 
Τίτλος/ID/µονάδες: 

 
Σχήµα 3.15: Ιδιότητες χρονοσειράς. 

 
ΠΡΟΣΟΧΗ: Οι τιµές των ιδιοτήτων που ορίζονται είτε δηµιουργώντας νέα χρονοσειρά (µέσω 
του µενού Series→ New), είτε έχοντάς τις τροποποιήσει ανά πάσα στιγµή, δεν θα 
αποθηκευτούν στην βάση δεδοµένων. Στην βάση δεδοµένων αποθηκεύονται µόνο οι 
εγγραφές της χρονοσειράς (ηµεροµηνίες - τιµές που αντιστοιχούν στις ηµεροµηνίες). Η 
τροποποίηση των ιδιοτήτων µπορεί να γίνει µόνο µέσω της φόρµας “Time series” (βλ 
Παράγραφο 3.6). 



 28

3.9 Επιλογή “View - As Table” - επισκόπηση χρονοσειράς ως πίνακα 
Ο πρακοθορισµένος (default) τρόπος απεικόνισης µίας χρονοσειράς είναι σε µορφή στήλης 
όπου οι εγγραφές της χρονοσειράς απεικονίζονται µε αύξουσα σειρά ως προς τον χρόνο. 
Εναλλακτικά µία χρονοσειρά µπορεί να απεικονιστεί µε την µορφή πίνακα. Η απεικόνιση της  
χρονοσειράς µε την µορφή πίνακα γίνεται χρησιµοποιώντας την επιλογή “As Table” από το 
µενού “View” της φόρµας “Time series data”. Η χρονοσειρά θα απεικονιστεί όπως 
παρακάτω: 

 
Σχήµα 3.16: Επισκόπηση χρονοσειράς ως πίνακα. 

 
Οι στήλες αυξάνουν σύµφωνα µε το χρονικό βήµα της χρονοσειράς (time step). Ωστόσο οι 
στήλες οµαδοποιούνται σε γραµµές του αµέσως ανώτερου χρονικού βήµατος. Στο 
παράδειγµα που απεικονίζεται παραπάνω, οι στήλες έχουν µηνιαία χρονική αύξηση εφόσον η 
χρονοσειρά είναι µηνιαία ενώ οι γραµµές οµαδοποιούν τους µήνες σε χρόνια. 

Η αρχή µέτρησης του χρόνου µπορεί να είναι η ηµερολογιακή (1 Ιανουαρίου) ή η αρχή του 
υδρολογικού έτους στην Ελλάδα (1 Οκτωβρίου), σύµφωνα µε την επιλογή “Hydrological 
year” του µενού “View”. 

Χρησιµοποιώντας την επιλογή “Show statistics” του µενού “View” εµφανίζονται στις 
γραµµές και τις στήλες στατιστικά για τα µείζονα και ελάσσονα χρονικά βήµατα (π.χ. 
στατιστικά Ιανουαρίου για όλα τα έτη ή στατιστικά 1990). 

Η απεικόνιση σε µορφή πίνακα είναι δυνατή για χρονοσειρές όπου έχουν χρονικό βήµα: 
Μηνιαίο, ηµερήσιο ή ωριαίο. Όταν απεικονίζονται ηµερήσιες ή ωριαίες χρονοσειρές, 
χρησιµοποιώντας τα κουµπιά της φόρµας “Previous” και “Next” αλλάζει αντίστοιχα, το έτος 
ή ο µήνας απεικόνισης. 

3.10 Επιλογή “View - Show flags” 
Χρησιµοποιώντας αυτήν την επιλογή, σε µία νέα στήλη, γειτονική στην ενεργή χρονοσειρά, 
εµφανίζονται και επισηµαίνονται τυχόν «Ενεργές σηµαίες». 
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3.11 Επιλογές “View - Highlight Mode” (Επισήµανση τιµών) 
Το υποµενού “Highlight Mode” µε τις επιλογές του απεικονίζεται παρακάτω: 

 
Σχήµα 3.17: Επιλογές επισήµανσης τιµών. 

 
Χρησιµοποιώντας µία από τις επιλογές (π.χ. No highlighted cells, Empty cells, κλπ) γίνεται 
γραφική επισήµανση στα κελιά (εγγραφές) που πληρούν τις προϋποθέσεις επισήµανσης. Για 
παράδειγµα χρήση της επισήµανσης “Maximum” (µέγιστη τιµή), επισηµαίνεται η εγγραφή µε 
την µέγιστη τιµή, σε κίτρινο φόντο: 

 
Σχήµα 3.18: Εφαρµογή λειτουργίας “Highlight”. 

3.12 Φίλτρα (Filters) 
Με την υποβολή κάποιας µεθόδου «φιλτραρίσµατος», είναι δυνατή η απεικόνιση των 
εγγραφών που πληρούν συγκεκριµένες συνθήκες (π.χ. µέσω ανισοτήτων). 

Χρησιµοποιώντας αρχικά την επιλογή “Set filter” του µενού “View”, καθορίζουµε τις 
συνθήκες απεικόνισης. Αυτό πραγµατοποιείται µε την βοήθεια της παρακάτω φόρµας: 

 
Σχήµα 3.19: Λειτουργίες «φιλτραρίσµατος». 
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Ενεργοποιώντας το φίλτρο που καθορίζεται στην παραπάνω φόρµα θα απεικονίζονται οι 
εγγραφές όπου η τιµή τους θα είναι µεγαλύτερη από (is greater than) 30. Επιπλέον είναι 
δυνατή η χρήση της αντίστροφης ανισότητας (µικρότερη τιµή από - is less than) ή η εµφάνιση 
- απόκρυψη τυχόν κενών εγγραφών (null). 

Φιλτράρισµα µπορεί να γίνει και µέσω των σηµαιών (flags) που έχουν ορισµένες εγγραφές, 
όπως εµφάνιση των εγγραφών που έχουν κάποια σηµαία σηκωµένη. 

Αν κατά την εµφάνιση φιλτραρισµένων εγγραφών, επιλεχθούν κάποιες εγγραφές προς 
διαγραφή, θα γίνει διαγραφή αποκλειστικά και µόνο των εγγραφών που απεικονίζονται. Με 
αυτόν τον τρόπο είναι δυνατή π.χ. η διαγραφή ακραίων τιµών. Επιπλέον, είναι δυνατή η 
αντιγραφή αποκλειστικά και µόνο των εγγραφών που απεικονίζονται σε κάποια εξωτερική 
εφαρµογή όπως είναι το Microsoft Excel. 

3.13 Έλεγχος ακραίων τιµών (Range check) και Έλεγχος χρονικής 
συνέπειας (Time consistency check) 

Η χρήση της επιλογής “Range Check” από το µενού “Tools” της φόρµας “Time series data”, 
ενεργοποιεί µία νέα φόρµα όπου θα τίθεται κάποια εµβέλεια τιµών (range), ώστε οι τιµές που 
θα είναι εκτός της εµβέλειας να επισηµαίνονται µε κάποια «σηµαία». Στην συνέχεια 
χρησιµοποιώντας π.χ. το «φιλτράρισµα» είναι δυνατή η εµφάνιση αποκλειστικά των τιµών 
µέσα σε αυτήν την εµβέλεια. Η φόρµα “Range check” απεικονίζεται στο παρακάτω σχήµα: 

 
Σχήµα 3.20: Έλεγχος ακραίων τιµών (Range check) 

 
Παρόµοια είναι η λειτουργικότητα του ελέγχου της χρονικής συνέπειας. Η λειτουργικότητα 
επιτυγχάνεται µέσω της παρακάτω φόρµας: 

 
Σχήµα 3.21: Έλεγχος χρονικής συνέπειας (Time consistency check). 

 
Η τιµή “Trigger value” αντιπροσωπεύει ένα κατώφλι όπου αν δύο διαδοχικές τιµές διαφέρουν 
κατά απόλυτη τιµή µεγαλύτερη από αυτό, οι τιµές µαρκάρονται µε το (σηκώνουν) σηµαιάκι 
που θα τίθεται στο “Mark time inconsistent values with flag:”. 
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3.14 Λειτουργία κανονικοποίησης (αναίρεση χρονικών µετατοπίσεων) 
χρονικού βήµατος (Regularize step) 

Η λειτουργία της κανονικοποίησης ενεργοποιείται από το µενού “Tools - Regularize step” της 
φόρµας “Time series data” και αποτελεί µία από τις επεξεργασίες που µπορεί να κάνει το 
λογισµικό «Υδρογνώµων» στις χρονοσειρές. Η επεξεργασία γίνεται στην ενεργή χρονοσειρά. 
Μετά το πέρας της επεξεργασίας, η χρονοσειρά αποκτά αυστηρό χρονικό βήµα (time step 
strict). Η λειτουργία ελέγχεται µέσω της παρακάτω φόρµας: 

 
Σχήµα 3.22: Φόρµα αναίρεσης χρονικών µετατοπίσεων 

 
Πρέπει να καθορίσετε: 

Ενδεχόµενη επιθυµητή χρονική µετατόπιση, π.χ. αν οι ωριαίες χρονοσειρές αφορούν 
εγγραφές σε χρόνους 00:20, 01:20 (µετατοπισµένες από τις ακέραιες ώρες κατά 20 λεπτά), 
κλπ πρέπει να τεθεί χρονική µετατόπιση 20 λεπτών (Offset in minutes). 

Τύπος µεταβλητής: Normal instantaneous (στιγµιαία), Vector (ανυσµατικές, π.χ. διεύθυνση 
ανέµου), Cumulative (αθροιστικές, π.χ. βροχόπτωση), change time move each record... (απλή 
χρονική µετατόπιση τιµών στο επιθυµητό χρονικό βήµα). 

3.15 Λειτουργία συνάθροισης (Aggression) - εξαγωγής χρονοσειράς 
µεγαλύτερου χρονικού βήµατος 

Οι λειτουργίες εξαγωγής χρονοσειράς µεγαλύτερου χρονικού βήµατος ενεργοποιούνται από 
το αντίστοιχο µενού της φόρµας “Time series data” (Tools - aggregation) και αφορούν 
συνάθροιση αθροιστικών µεταβλητών (π.χ. βροχόπτωση, ηλιοφάνεια), εξαγωγή µέσης τιµής 
ή ελάχιστων ή µέγιστων στιγµιαίων µεταβλητών ή στιγµιαίας τιµής στην αρχή του χρονικού 
διαστήµατος ή εξαγωγή µέσης τιµής ανυσµατικού µεγέθους (vector). Η επεξεργασία γίνεται 
στην ενεργή χρονοσειρά και έχει ως αποτέλεσµα µία νέα χρονοσειρά χρονικού βήµατος µίας 
τάξης µεγαλύτερης (δεκάλεπτο→  ωριαίο→ ηµερήσιο→ µηνιαίο→ ετήσιο). 
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Σχήµα 3.23: Συνάθροιση χρονοσειρών - εξαγωγή χρονοσειράς µεγαλύτερου χρονικού 

βήµατος. 
 
Οι χρονοσειρές που θα υποστούν την επεξεργασία πρέπει να έχουν αυστηρό χρονικό βήµα 
(time step strict). Εφόσον συναθροίζονται δεκάλεπτες, ωριαίες ή ηµερήσιες χρονοσειρές θα 
πρέπει να καθοριστεί η χρονική µετατόπιση (Time offset). Επιπλέον, πρέπει να καθοριστεί το 
µέγιστο πλήθος ελλειπουσών τιµών ώστε η συναθροισµένη τιµή να είναι αποδεκτή (Number 
of missing values to accept). 

Το αποτέλεσµα της επεξεργασίας είναι δύο νέες χρονοσειρές που απεικονίζονται ως στήλες 
στην φόρµα “Time series data”, η πρώτη περιέχει την συναθροισµένη χρονοσειρά ενώ η 
δεύτερη το πλήθος των ελλειπουσών τιµών για κάθε νέα εγγραφή. 

 
Σχήµα 3.24: Αποτέλεσµα συνάθροισης: Συναθροισµένη χρονοσειρά και χρονοσειρά πλήθους 

ελλειπουσών τιµών. 
 

3.16 Λειτουργία γραµµικής παλινδρόµησης (regression) 
Η λειτουργία παλινδρόµησης ενεργοποιείται από το αντίστοιχο µενού της φόρµας “Time 
series data” (Tools→ regression) και αφορά την πολλαπλή παλινδρόµηση µεταξύ 
χρονοσειρών. Η ενεργή χρονοσειρά θεωρείται ως εξαρτηµένη µεταβλητή, ενώ οι υπόλοιπες 
απεικονισµένες χρονοσειρές είναι οι ανεξάρτητες µεταβλητές. Η φόρµα επεξεργασίας 
απεικονίζεται παρακάτω: 
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Σχήµα 3.25: Λειτουργίες γραµµικής παλινδρόµησης 

 
Η επιλογή “Zero constant term” αφορά συσχέτιση µε µηδενικό σταθερό όρο. Η λειτουργία 
“Seasonal” αφορά εποχιακή συσχέτιση, δηλαδή διαφορετικούς συντελεστές γραµµικής 
παλινδρόµησης για κάθε µήνα χωριστά. 

Στο παρακάτω σχήµα φαίνεται ένα παράδειγµα υπολογισµού των συντελεστών πολλαπλής 
συσχέτισης, από τα δεδοµένα 3 χρονοσειρών. Η πρώτη χρονοσειρά είναι η ενεργή, συνεπώς 
είναι η εξαρτηµένη µεταβλητή. 

 
Σχήµα 3.26: Παράδειγµα πολλαπλής παλινδρόµισης. 

 
Τα αποτελέσµατα απεικονίζονται στην νέα φόρµα “Regression results”. Το N αφορά το 
πλήθος των εγγραφών µε τις οποίες έγινε συσχέτιση. R, R2, οι συντελεστές γραµµικής 
συσχέτισης. a0 ο σταθερός όρος ενώ a1, a2 οι πολλαπλασιαστές για την πρώτη ανεξάρτητη 
µεταβλητή και δεύτερη ανεξάρτητη µεταβλητή αντίστοιχα. 

3.17 Γραµµικές πράξεις µεταξύ χρονοσειρών 
Χρησιµοποιώντας το µενού “Tools - Linear Combinations”, ενεργοποιείται η παρακάτω 
φόρµα: 
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Σχήµα 3.27: Γραµµικοί συντελεστές για τις γραµµικές πράξεις. 

 
Οι γραµµικές πράξεις συνοψίζονται στην παρακάτω σχέση: 

v = c + a1*v1 + a2*v2 + ... + an*vn 

όπου c ένας σταθερός όρος, v1,v2,...,vn n χρονοσειρές και a1...an οι n πολλαπλασιαστικοί 
συντελεστές. 

Ο σταθερός όρος εισάγεται στο πεδίο “Constant Coefficient” ενώ οι πολλαπλασιαστικοί 
συντελεστές στα πεδία δεξιά των τίτλων των χρονοσειρών. 

3.18 Λειτουργίες απεικόνισης γραφηµάτων χρονοσειρών (Graph) 
Οι χρονοσειρές της φόρµας “Time series data” απεικονίζονται σε µορφή γραφήµατος όπου ο 
οριζόντιος άξονας απεικονίζει την κλίµακα του χρόνου ενώ ο κατακόρυφος τις τιµές των 
εγγραφών της χρονοσειράς. 

Με την απεικόνιση των χρονοσειρών σε γράφηµα παρουσιάζεται µία συνολική εικόνα για τις 
τιµές της χρονοσειράς και προσφέρεται εποπτεία ως προς τις ακρότατες τιµές, την χρονική 
συνέπεια καθώς και τα διαστήµατα ελλειπουσών τιµών. 

Η ενεργοποίηση των γραφηµάτων γίνεται µέσω του µενού “Graph - Add timeseries to graph” 
της φόρµας “Time series data”. Οι διαφορετικές χρονοσειρές απεικονίζονται µε διαφορετικά 
χρώµατα τα οποία αποδίδονται αυτόµατα. Προϋπόθεση σχεδιασµού πολλαπλών γραφηµάτων 
είναι οι προς σχεδιασµό χρονοσειρές να έχουν τις ίδιες µονάδες. Αυτός ο περιορισµός αίρεται 
χρησιµοποιώντας την επιλογή “Graph - Allow Different Units”. Τέλος µε την επιλογή “Clear 
Graph”, γίνεται καθαρισµός της φόρµας γραφηµάτων. Παρακάτω παρουσιάζεται η φόρµα 
των γραφηµάτων: 
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Σχήµα 3.28: Παράθυρο γραφηµάτων. 

 
Τα µενού της φόρµας “Time series graph” συνοψίζονται παρακάτω: 

File→ Print: Εκτυπώνει το τρέχον γράφηµα χρονοσειρών στον προκαθορισµένο εκτυπωτή 
(default printer). 

File→ Save as bitmap: Αποθήκευση του τρέχοντος γραφήµατος σε αρχείο εικόνας. (bmp) 

File→ Close window: Κλείνει το παράθυρο των γραφηµάτων. 

Edit→ Copy to clipboard: Τυπική λειτουργία των windows. Το τρέχον γράφηµα 
αντιγράφεται µέσω του “clipboard” π.χ. σε κάποιον επεξεργαστή κειµένου όπως είναι ο 
«Microsoft Word». 

Edit→ Clear graph: Η ίδια λειτουργία µε το Time series data → Clear Graph. 

View→ Undo zoom (Ctrl+Z): Αναίρεση της µεγέθυνσης. Η λειτουργία αυτή µπορεί να 
αναπαραχθεί σέρνοντας το ποντίκι από κάτω δεξιά - πάνω αριστερά στον χώρο του 
γραφήµατος. 

View→ Refresh (F5): Επανασχεδιάζονται τα γραφήµατα. Εάν έχουν αλλάξει κάποιες τιµές 
στις χρονοσειρές, εµφανίζονται αυτές οι αλλαγές. 
View→ Cycle colors (F6): Γίνεται χρωµατική εναλλαγή ώστε οι διαφορετικές χρονοσειρές να 
αποκτήσουν τα χρώµατα που προτιµά ο χρήστης. 

Thin / thick lines (F7 / F8): Μεταβάλλεται το πάχος της γραµµής των γραφηµάτων. 

View → Zoom in / out: ή µε τα πλήκτρα “Insert” και “Delete”. 

Λειτουργίες ποντικιού: 

Zoom rectangle (µεγέθυνση περιοχής): Σέρνουµε το ποντίκι πάνω στο γράφηµα µε το 
αριστερό κουµπί πατηµένο, από πάνω αριστερά προς κάτω δεξιά, ορίζοντας την περιοχή 
µεγέθυνσης. 

Pan: Με το δεξί κουµπί πατηµένο µπορούµε να «σύρουµε» το γράφηµα. Η λειτουργία µπορεί 
να γίνει και µε τα βελάκια στα πλήκτρα (δεξιά, αριστερά, πάνω και κάτω). 
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4 Υπολογισµός του ύψους της εξάτµισης 

4.1 Γενικά για τον υπολογισµό του ύψους εξάτµισης 
Ο υπολογισµός του ύψους εξάτµισης, αφορά µία διαδικασία έµµεσου υπολογισµού του 
µεγέθους από µετρηµένα µετεωρολογικά στοιχεία. Συγκεκριµένα ο υπολογισµός του ύψους 
εξάτµισης κατά Penman (µεθοδολογία διεθνώς αποδεκτή) δέχεται ως δεδοµένα: 

��Θερµοκρασία (oC) 
��Σχετική υγρασία (%) 
��Ταχύτητα ανέµου (m/s) και 
��∆ιάρκεια ηλιοφάνειας (min) 

Το λογισµικό «Υδρογνώµων» µπορεί να κάνει τον ως άνω υπολογισµό, χρησιµοποιώντας 
χρονοσειρές που περιέχουν τα παραπάνω µετεωρολογικά δεδοµένα. 

Επιπλέον δίνει την δυνατότητα υπολογισµού µε προσεγγιστικές µεθόδους, µικρότερης 
ακρίβειας και συγκεκριµένα µε την µέθοδο Thornthwaite και την εµπειρική - παραµετρική 
εξίσωση (Κουτσογιάννης, 1997). Οι µέθοδοι αυτοί έχουν τις ελάχιστες απαιτήσεις δεδοµένων 
(συνήθως την χρονοσειρά θερµοκρασίας). 

Οι υπολογισµοί που γίνονται µε την µέθοδο του Penman, αναπτύσσονται από τους 
Κουτσογιάννη και Ξανθόπουλου στο βιβλίο «Τεχνική Υδρολογία» (Ε.Μ.Π. 1997). 

4.2 ∆εδοµένα - χρονοσειρές 
Τα δεδοµένα πρέπει να είναι µέσα ηµερήσια ή µηνιαία για τις χρονοσειρές της θερµοκρασίας, 
σχετικής υγρασίας και ταχύτητας ανέµου. Όσον αφορά δε την διάρκεια ηλιοφάνειας πρέπει 
να είναι συνολικά λεπτά ηλιοφάνειας για την ηµέρα ή µήνα όπου θα υπολογιστεί το ύψος 
εξάτµισης. Ειδικά για τις µεθόδους (Thornthwaite - Κουτσογιάννης, Ξανθόπουλος 1997) η 
µέση θερµοκρασία πρέπει να έχει µηνιαίο χρονικό βήµα. 

Το αποτέλεσµα το οποίο µπορεί να είναι είτε η ηµερήσια είτε η µηνιαία εξάτµιση δίνεται σε 
χιλιοστά (mm). 

Η υπολογιστική διαδικασία του Penman δίνει ορθότερα αποτελέσµατα για την συνολική 
µηνιαία εξάτµιση, έτσι προτείνεται η εφαρµογή της σε µηνιαίες χρονοσειρές για την εξαγωγή 
µηνιαίας χρονοσειράς ύψους εξάτµισης. Εναλλακτικά µπορεί να εφαρµοστεί σε ηµερήσια 
δεδοµένα για την εξαγωγή του ηµερήσιου ύψους εξάτµισης. 

4.3 Ενεργοποίηση 
Ο υπολογισµός του ύψους εξάτµισης γίνεται µε την βοήθεια µίας φόρµας του λογισµικού 
«Υδρογνώµων». 

Η ενεργοποίηση (εµφάνιση) αυτής της φόρµας γίνεται από το µενού “Tools - Evaporation” 
της φόρµας “Time series data”. 
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Ο υπολογισµός κατά Penman είναι δυνατός εφόσον έχουν φορτωθεί στην φόρµα “Time series 
data” ακριβώς τέσσερις χρονοσειρές µε την εξής σειρά: 

��Θερµοκρασία (oC) 
��Σχετική υγρασία (%) 
��Ταχύτητα ανέµου (m/s) και 
��∆ιάρκεια ηλιοφάνειας (min) 

Για τον υπολογισµό κατά Thornthwaite ή µε την εµπειρική σχέση, απαιτείται µόνο η 
(µηνιαία) χρονοσειρά της θερµοκρασίας. Οι υπολογισµοί σε αυτήν την περίπτωση γίνονται 
στην ενεργή χρονοσειρά. 

4.4 Φόρµα υπολογισµών 
Η φόρµα υπολογισµών απεικονίζεται στο παρακάτω σχήµα: 

 
Σχήµα 4.1: Φόρµα υπολογισµού της εξάτµισης. 

Τα πεδία εισαγωγής παραµέτρων είναι τα εξής: 

Γεωγραφικό Πλάτος (Latitude) σε µοίρες, πρώτα λεπτά και δευτερόλεπτα. 

Υψόµετρο (Altitude) σε µέτρα. 

Λευκαύγεια (Albedo). (αδιάστατο) 

Παράµετροι υπολογισµού του ύψους εξάτµισης σύµφωνα µε την µέθοδο του Penman 
(Parameters: Ae, Be, aL, bL, As, Bs). Οι παράµετροι αυτοί εισάγονται προαιρετικά από τον 
χρήστη - είναι δυνατή η χρήση των αρχικών ρυθµίσεων (defaults). 

Το κουµπί «OK» κλείνει την φόρµα αφού γίνουν οι υπολογισµοί ενώ το κουµπί «Cancel» 
κλείνει την φόρµα χωρίς να πραγµατοποιηθούν υπολογισµοί. 

Στην λίστα επιλογής “Calculation” καθορίζεται η µέθοδος υπολογισµού: 

Στον υπολογισµό κατά Penman, εισάγονται όλες οι παραπάνω τιµές. 

Στον υπολογισµό κατά Thornthwaite, απαιτείται µόνο το γεωγραφικό πλάτος. 

Στον υπολογισµό σύµφωνα µε την εµπειρική σχέση, απαιτείται το γεωγραφικό πλάτος καθώς 
και οι τρεις εµπειρικές παράµετροι: a, b, c. 
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4.5 Εκτέλεση υπολογισµών 
Αρχικά, πριν ενεργοποιηθεί η φόρµα για τον υπολογισµό της εξάτµισης, πρέπει να έχουν 
φορτωθεί οι τέσσερις απαραίτητες χρονοσειρές στην φόρµα “Time series data”, όπως στο 
παρακάτω σχήµα (απαραίτητη προϋπόθεση µόνο για τον υπολογισµό κατά Penman): 

 
Σχήµα 4.2: Υπολογισµός συνολικού χρόνου ηλιοφάνειας, ενεργοποίηση υπολογισµού ύψους 

εξάτµισης. 
 
Η τέταρτη χρονοσειρά (χρονοσειρά ηλιοφάνειας σε λεπτά), προήλθε από µετατροπή κάποιας 
ηµερήσιας χρονοσειράς ηλιοφάνειας που ήταν σε ώρες. Η µετατροπή έγινε µε την 
επεξεργασία των γραµµικών πράξεων της φόρµας “Time series data”, πολλαπλασιάζοντας την 
αρχική χρονοσειρά µε 60. Εάν η χρονοσειρά ηλιοφάνειας είχε µικρότερο χρονικό βήµα, είναι 
απαραίτητη η διαδικασία της συνάθροισης (aggregation). 

Αφού ενεργοποιηθεί η φόρµα για τον υπολογισµό της εξάτµισης, πρέπει να τεθούν οι 
παράµετροι υπολογισµού. Τέλος πατώντας το κουµπί “OK”, γίνονται οι απαραίτητοι 
υπολογισµοί και η ζητούµενη χρονοσειρά (ύψος εξάτµισης σε mm) απεικονίζεται στην 
φόρµα “Time series data” ως παρακάτω: 
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Σχήµα: 4.3: Υπολογισµένο ύψος εξάτµισης σύµφωνα µε την µεθοδολογία του Penman. 
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5 Παρεµβολές 

5.1 Σκοπός - γενικά 
Είναι συνηθισµένη πρακτική, κάποια από τα υδρολογικά µεγέθη να υπολογίζονται έµµεσα, 
χρησιµοποιώντας µετρηµένα µεγέθη σε συνδυασµό µε κάποιο µαθηµατικό µοντέλο 
παρεµβολής. Αυτό συνηθίζεται όταν είναι αδύνατη η άµεση µέτρηση κάποιου µεγέθους (π.χ. 
όγκος ταµιευτήρα) ή τεχνικά δύσκολη η συνεχής καταγραφή (π.χ. παροχή ρέµατος). Οι 
ειδικότερες περιπτώσεις, όπου το λογισµικό «Υδρογνώµων» µπορεί να επιλύσει είναι: 

��Υπολογισµός παροχής από µετρήσεις στάθµης. 
��Υπολογισµός όγκου (αποθέµατος) και επιφάνειας ταµιευτήρα από την µέτρηση στάθµης. 
��Υπολογισµός διαφυγών ταµιευτήρα από την µέτρηση στάθµης. 
��Υπολογισµός παροχής υπερχείλισης από την µέτρηση στάθµης υπερχείλισης. 

Σκοπός λοιπόν είναι, να υπολογιστεί µία παράγωγη χρονοσειρά (π.χ. όγκου) 
χρησιµοποιώντας κάποια χρονοσειρά στάθµης και κάποιο παρεµβολικό µοντέλο. 

Τα παρεµβολικά µοντέλα που χρησιµοποιούνται είναι κάποιο από τα παρακάτω: 

Μία συλλογή από καµπύλες στάθµης παροχής, εκθετικού τύπου, όπου κάθε καµπύλη έχει 
χρονικό διάστηµα εγκυρότητας. Επιπλέον, µία συλλογή από καµπύλες επέκτασης 
(υπολογισµένες µε υδραυλική µέθοδο) όπου κάθε καµπύλη µπορεί να έχει επίσης 
διαφορετικό χρονικό διάστηµα εγκυρότητας. 

Καµπύλη στάθµης-αποθέµατος και καµπύλη στάθµης-επιφάνειας για κάποιον ταµιευτήρα. Η 
µορφή της καµπύλης εξαρτάται από την τοπογραφία (µορφολογία, υψοµετρικές καµπύλες) 
του ταµιευτήρα.  

Μία συλλογή καµπυλών στάθµης - διαφυγών ταµιευτήρα όπου κάθε καµπύλη θα έχει κάποιο 
εποχιακό διάστηµα εγκυρότητας (π.χ. Ιανουάριος-Μάρτιος). Η µορφή των καµπυλών 
αποδίδεται µέσω ενός πολυώνυµου τρίτου βαθµού. 

Μια εκθετική καµπύλη στάθµης - παροχής υπερχειλιστή φράγµατος. 
Είναι δε δυνατή η επιβολή µερικών διορθώσεων π.χ. «καλιµπράροντας» τις πυκνές 
χρονοσειρές που προκύπτουν από κάποια καταγραφική συσκευή µε χρήση κάποιας 
ακριβέστερης (αραιότερης) χρονοσειράς που προκύπτει από άµεση παρατήρηση. Επιπλέον, 
στους υπολογισµούς της παροχής από στάθµη είναι δυνατή η διόρθωση της στάθµης (stout 
correction) χρησιµοποιώντας τις υδροµετρήσεις (ταυτόχρονες µετρήσεις στάθµης-παροχής). 

5.2 Ενεργοποίηση 
Οι παρεµβολές γίνονται σε χρονοσειρές που έχουν προηγουµένως φορτωθεί στην φόρµα του 
λογισµικού «Υδρογνώµων» «Time series data». Στην εικόνα που ακολουθεί φαίνονται 
µερικές χρονοσειρές που έχουν φορτωθεί στην παραπάνω φόρµα: 
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Σχήµα 5.1: Φορτωµένες χρονοσειρές στάθµης, παροχής. 

 
Στο συγκεκριµένο παράδειγµα, η χρονοσειρά 59 αφορά µέτρηση στάθµης από σταθµηγράφο, 
η χρονοσειρά 58 µέτρηση στάθµης από σταθµήµετρο και οι χρονοσειρές 60,61 
υδροµετρήσεις στάθµης-παροχής, όλες οι χρονοσειρές από τον υδροµετρικό σταθµό «Πόρο 
Ρηγανίου» 

Η ενεργοποίηση της φόρµας παρεµβολών (Interpolations) είναι δυνατή εφόσον έχουµε 
φορτώσει τουλάχιστον µία χρονοσειρά στην φόρµα “Time series data”. Η εµφάνιση αυτής 
της φόρµας γίνεται µε χρήση του µενού Tools→Interpolations όπως φαίνεται στο παρακάτω 
σχήµα: 

 
Σχήµα 5.2: Menu ενεργοποίησης φόρµας για τις παρεµβολές. 

 

5.3 Λειτουργίες 
Στο παρακάτω σχήµα, απεικονίζεται η φόρµα των παρεµβολών, έχοντας ενεργοποιήσει την 
λειτουργικότητα για υπολογισµούς στάθµης-παροχής και έχοντας φορτώσει µία συλλογή 
καµπυλών που αφορούν τον «Πόρο Ρηγανίου» (καµπύλες στάθµης-παροχής από την βάση 
δεδοµένων µε ID=16). 
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Σχήµα 5.3: Φόρµα για τις παρεµβολές. Απεικόνιση συλλογής καµπυλών στάθµης παροχής µε 

ID=16 (από τον σταθµό «Πόρος Ρηγανίου»). 
 
Η φόρµα χωρίζεται στους παρακάτω βασικούς τοµείς: 

Είδος υπολογισµών (Type of calculations). Γίνεται η επιλογή µεταξύ: υπολογισµό στάθµης-
παροχής (Stage-Discharge), στάθµης-αποθέµατος, επιφάνειας (Stage-Area, Volume), 
στάθµης-υπόγειων διαφυγών (Stage-Leakage) καθώς και στάθµης-παροχής υπερχείλισης 
(Spillway Stage-Discharge). 

Άνοιγµα / αποθήκευση καµπύλων (Load / Save) από / σε αρχείο / βάση δεδοµένων (File / DB). 

Καθορισµός τύπου χρονοσειρών (Required Time Series <-> Assign to). 

Γράφηµα όπου εµφανίζονται οι καµπύλες που έχουν φορτωθεί, µαζί µε τις επιλογές για 
λογαριθµικοποιηµένους άξονες (log XAxis, log YAxis). 

Επιλογές (Options) που αναφέρονται στις διορθώσεις που θα γίνουν αν διατίθενται 
χρονοσειρές µεγαλύτερης ακρίβειας (π.χ. σταθµηγράφος<->σταθµήµετρο) κλπ. 

Επιπλέον υπολογισµοί (π.χ. Stage-Discharge Calculations για υπολογισµούς στάθµης-
παροχής). Μπορούν να υπολογιστούν οι στιγµιαίες (instantaneous) τιµές π.χ. παροχών ή / και 
αθροιστικές (cumulative) ή µέσες (averages) τιµές. Η άθροιση / εξαγωγή µέσων τιµών γίνεται 
µε διαδικασία χρονικής ολοκλήρωσης (time integration) ώστε να αντιµετωπίζονται και οι 
ακανόνιστες χρονοσειρές από τις στάθµες. Ωστόσο συνιστάται η διαδικασία χρήσης των 
υπόλοιπων εργαλείων του λογισµικού «Υδρογνώµων» όπως “Regularize step”, “Aggregate” 
κλπ ώστε να προκύψουν συναθροισµένες χρονοσειρές όπου µπορούν να πολλαπλασιαστούν 
στην συνέχεια µέσω των «γραµµικών πράξεων» - “Linear calculations”. 

Εµφάνιση σηµείων υδροµετρήσεων H-Q (µόνο στους υπολογισµούς στάθµης – παροχής). 

Κουµπί διενέργειας υπολογισµών (Calculate). 
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5.4 Ανάκτηση – αποθήκευση καµπύλων 

 
Σχήµα 5.4: Ανάκτηση, αποθήκευση καµπύλων. 

 
Οι καµπύλες θα φορτώνονται (Load Curves) είτε από την βάση δεδοµένων (from DB) 
εισάγοντας ένα έγκυρο αριθµό ID που θα αντιστοιχεί σε καµπύλες κατάλληλες για τους 
υπολογισµούς που θα γίνουν, είτε από κάποιο αρχείο κειµένου (from File) το οποίο: 

��Μπορεί να έχει αποθηκευτεί από την φόρµα παρεµβολών µέσω της λειτουργίας “Save 
Curves to File”. 

��Μπορεί να έχει συνταχθεί από τον χρήστη, τροποποιώντας π.χ. κάποιο υπάρχον αρχείο 
καµπυλών που έχει αποθηκευτεί µε τον παραπάνω τρόπο. 

Αντίστοιχα είναι δυνατή η αποθήκευση των δεδοµένων των καµπύλων (Save Curves) στην 
βάση δεδοµένων (to DB) ή σε κάποιο αρχείο κειµένου (to File). 

5.5 Είδος υπολογισµών 

 
Σχήµα 5.5: Επιλογή του είδους υπολογισµών. 

 
Οι επιλογές των υπολογισµών είναι οι παρακάτω: 

��Υπολογισµός Στάθµης-Παροχής (Stage-Discharge). 
��Υπολογισµός Στάθµης-Αποθέµατος, Επιφάνειας (Stage-Area, Volume). 
��Υπολογισµός Στάθµης-Υπόγειων διαφυγών (Stage-Leakage). 
��Υπολογισµός Στάθµης-Παροχής υπερχείλισης (Spillway Stage-Discharge). 

Σε κάθε αλλαγή είδους υπολογισµού, αποφορτώνονται τυχών καµπύλες που έχουν φορτωθεί 
στην µνήµη, απενεργοποιούνται επιλογές που δεν έχουν νόηµα για το είδος των υπολογισµών 
(για παράδειγµα. η διόρθωση “Stout” έχει νόηµα µόνο στους υπολογισµούς Στάθµης-
Παροχής) και τίθενται κάποιες κατ’ αρχήν (default) ρυθµίσεις για το είδος των υπολογισµών. 

5.6 Καθορισµός τύπου χρονοσειρών 
Πριν γίνουν οι υπολογισµοί, πρέπει να καθοριστεί το είδος των χρονοσειρών που είναι ήδη 
φορτωµένες στην φόρµα “Time series data”. Θα χρησιµοποιούνται οι δύο παρακάτω λίστες: 
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Σχήµα 5.6: Τύπος χρονοσειρών, λίστα µε τις φορτωµένες χρονοσειρές στην φόρµα “Time 

series data”. 
 
Πατώντας σε κάποια από τις γραµµές της πρώτης λίστας (π.χ. Dense Stage TS, Sparse ...), 
ενεργοποιείται η αντιστοίχιση στην δεύτερη λίστα (Assign to :). Η αντιστοίχιση µπορεί να 
αλλάξει µε διπλό κλικ στην δεύτερη λίστα, στην επιθυµητή χρονοσειρά. 

Στην περίπτωση υπολογισµών Στάθµης-Παροχής, µέχρι και τέσσερις χρονοσειρές µπορούν 
να χρησιµοποιηθούν. Η “Dense Stage TS (Required)” αναφέρεται στην απολύτως απαραίτητη 
χρονοσειρά για να γίνουν οι υπολογισµοί, συνήθως δε, είναι οι στάθµες µετρηµένες συνήθως 
από κάποια καταγραφική µονάδα. Η “Sparse Stage TS (Accurate)” παρουσιάζεται και στους 
υπόλοιπους υπολογισµούς (αποθέµατος, διαφυγών) και αναφέρεται σε µία ακριβέστερη 
χρονοσειρά, µεγαλύτερου χρονικού βήµατος, µε χρήση της οποίας είναι δυνατό το 
«καλιµπράρισµα» της χρονοσειράς του καταγραφικού. Οι χρονοσειρές “HQ measurements, 
Stage TS & Discharge TS” αναφέρονται σε χρονοσειρές υδροµετρήσεων στάθµης και 
παροχής και εισάγονται µόνο για υπολογισµούς Στάθµης-Παροχής. 

5.7 Σηµεία υδροµετρήσεων 
Εφόσον έχει φορτωθεί κάποια οικογένεια καµπύλων και έχουν καθοριστεί οι χρονοσειρές 
υδροµετρήσεων, είναι δυνατή η εµφάνιση των σηµείων υδροµετρήσεων στο γράφηµα των 
καµπύλων, πατώντας το κουµπί: 

 
Σχήµα 5.7: Κουµπί για την εµφάνιση των σηµείων των υδροµετρήσεων. 

 
Το αποτέλεσµα φαίνεται στην παρακάτω εικόνα: 
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Σχήµα 5.8: Απεικόνιση καµπυλών στάθµης - παροχής, σηµείων υδροµετρήσεων. 

 

5.8 Λογαριθµικοί άξονες 
Οι άξονες του γραφήµατος που απεικονίζουν συνήθως την στάθµη και κάποιο άλλο µέγεθος, 
µπορούν να έχουν γραµµική ή λογαριθµική κλίµακα. 

Αυτό µπορείτε να αλλάξει χρησιµοποιώντας τις επισηµάνσεις Log XAxis ή Log YAxis, όπως 
η παρακάτω: 

 
Σχήµα 5.9: Κουµπί για την αλλαγή του άξονα από γραµµική σε λογαριθµική κλίµακα. 

 
Καθώς αλλάζει το είδος των υπολογισµών, οι παραπάνω επισηµάνσεις τίθενται αυτόµατα σε 
κάποιες καταρχήν ρυθµίσεις σύµφωνα µε το είδος των υπολογισµών. 

5.9 Επιλογές υπολογισµών 

 
Σχήµα 5.10: Επιλογές υπολογισµών. 

 
Ανάλογα µε το είδος υπολογισµών που έχει επιλεγεί, είναι δυνατή η επέµβαση σε κάποιες 
από τις παραπάνω ρυθµίσεις. Στην περίπτωση υπολογισµού Στάθµης-Παροχής, επιτρέπεται η 
επέµβαση σε όλες τις παραπάνω ρυθµίσεις οι οποίες είναι: 

∆ιόρθωση της πυκνής χρονοσειράς στάθµης (Dense Stage TS) χρησιµοποιώντας ακριβέστερη 
χρονοσειρά µεγαλύτερου χρονικού βήµατος (Make H1 Correction (from Accu. TS)) 

Συνένωση της (διορθωµένης ενδεχοµένως) αραιής και της πυκνής χρονοσειράς (Merge Sparse 
+ Dense Stage Data) 
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∆ιόρθωση της χρονοσειράς που προκύπτει ενδεχοµένως µε χρήση των δύο παραπάνω 
επιλογών «καλιµπράροντας» µε την χρονοσειρά που περιέχει τις στάθµες από τις 
υδροµετρήσεις (Make H2 Correction (from H-Q)) – ( µόνο για στάθµη παροχή) 

∆ιόρθωση Stout (Make stout Correction) µόνο για υπολογισµούς Στάθµης-Παροχής φυσικά 
και εφόσον έχουν φορτωθεί χρονοσειρές υδροµετρήσεων. 

Calculate Discharge ή Volume κλπ. Υπολογισµός δηλαδή της παροχής ή όποιου µεγέθους 
έχει επιλεγεί να γίνει υπολογισµός (π.χ. Απόθεµα). Είναι δυνατή η µη διενέργεια του τελικού 
υπολογισµού άλλα έχοντας επιλέξει κάποιες από τις παραπάνω επιλογές να υπολογιστούν 
διορθώσεις σε κάποιες χρονοσειρές οι οποίες στην συνέχεια θα εξαχθούν στην φόρµα “Time 
series data”. 

5.10 Επιπλέον υπολογισµοί 

 
Σχήµα 5.11: Επιλογή επιπλέον υπολογισµών. 

 
Ο χρήστης µπορεί να απαιτήσει επιπλέον υπολογισµούς. Για παράδειγµα όταν γίνεται 
υπολογισµός Στάθµης-Παροχής, µπορεί να ζητηθούν µόνο οι στιγµιαίες τιµές παροχής 
(instantaneous values) ή και οι συναθροισµένες τιµές (όγκοι για την περίπτωση της παροχής) 
(cumulative values) ή και οι µέσες τιµές παροχής (averages). Οι επιπλέον υπολογισµοί θα 
εµφανιστούν ως νέες χρονοσειρές στην φόρµα “Time series data”. 

5.11 ∆ιενέργεια υπολογισµών 
Οι υπολογισµοί (διορθώσεις και εξαγωγή τελικού µεγέθους) εκτελούνται αφού πατηθεί το 
κουµπί “Calculate”: 

 
Σχήµα 5.12: Κουµπί “Calculate” για την διενέργεια των υπολογισµών. 

 
Τα αποτελέσµατα εµφανίζονται ως νέες χρονοσειρές στην φόρµα “Time series data” όπως 
παρακάτω, µαζί µε τις αρχικές χρονοσειρές (δεδοµένα υπολογισµών): 
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Σχήµα 5.13: ∆εδοµένα και αποτελέσµατα υπολογισµών, όπως απεικονίζονται στην φόρµα 

“Time series data”. 
 
Στο παραπάνω παράδειγµα εκτός από την τελική χρονοσειρά της παροχής (Discharge) 
εµφανίζονται όλες οι ενδιάµεσες διορθώσεις καθώς και διορθωµένες χρονοσειρές. 
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6 Οντότητες πραγµατικού κόσµου (Γεωγραφικές 
οντότητες - Gentities) 

6.1 Γενικά για τις γεωγραφικές οντότητες 
Οι γεωγραφικές οντότητες (εφεξής θα καλούνται και ως “gentities”) αφορούν αντικείµενα 
στον χώρο µε υδρολογική σηµασία. Οι γεωγραφικές οντότητες περιγράφονται από την θέση 
τους (σε κάποιο γεωγραφικό σύστηµα συντεταγµένων), το µέγεθός τους εφόσον αυτό έχει 
νόηµα καθώς και από ιδιότητες ειδικές για κάθε τύπο γεωγραφικής οντότητας (π.χ. ύψος 
υπερχείλισης για φράγµα). Επιπλέον κάθε γεωγραφική οντότητα µπορεί να περιέχει µία ή 
περισσότερες χρονοσειρές κάποιου µεγέθους που συσχετίζεται µε την γεωγραφική οντότητα 
(π.χ. χρονοσειρά στάθµης ενός ταµιευτήρα, χρονοσειρά θερµοκρασίας ενός µετεωρολογικού 
σταθµού κ.α.) 

Οι τέσσερις βασικές κατηγορίες γεωγραφικών οντοτήτων είναι οι παρακάτω: 

��Σηµεία: Μετρητικοί σταθµοί (µετεωρολογικοί ή υδροµετρικοί), φράγµατα, πόλεις, 
γεωτρήσεις, διυλιστήρια, πηγές, αντλίες και γεννήτριες. 

��Γραµµές: Τµήµατα υδραγωγείου. 
��∆ίκτυα: Υδραγωγεία (αποτελούµενα από τµήµατα υδραγωγείου). 
��Επιφάνειες: Ταµιευτήρες, λεκάνες απορροής. 

Το λογισµικό «Υδρογνώµων» παρέχει εργαλεία για διαχείριση των γεωγραφικών οντοτήτων 
που περιέχονται στην βάση δεδοµένων. Επιτρέπει την δηµιουργία, τροποποίηση και διαγραφή 
γεωγραφικών οντοτήτων καθώς και παραµέτρων που συσχετίζονται µε αυτές (π.χ. καµπύλες 
στάθµης παροχής, καµπύλες στάθµης - αποθέµατος ταµιευτήρα κ.α.). Επιπλέον παρέχει απλά 
υπολογιστικά εργαλεία όπως για τον υπολογισµό του ισοζυγίου ταµιευτήρων. 

6.2 ∆ιαχείριση γεωγραφικών οντοτήτων 
Η διαχείριση των γεωγραφικών οντοτήτων γίνεται µέσω ενός κοινού παραθύρου (φόρµας) 
που διαφοροποιείται κατά περίπτωση ώστε να περιέχει τις ιδιότητες της συγκεκριµένης 
γεωγραφικής οντότητας (π.χ. στα φράγµατα πρέπει να µπορούµε να δούµε /τροποποιήσουµε 
την τιµή του ύψους υπερχείλισης, τιµή η οποία δεν έχει νόηµα π.χ. για µία αντλία).  

Η ενεργοποίηση των φορµών γεωγραφικών οντοτήτων γίνεται από το κοινό µενού των 
εφαρµογών του λογισµικού  «Υδρογνώµων» (Windows) ή κατά την εκκίνηση του λογισµικού 
«Υδρογνώµων» εφόσον έχει ρυθµιστεί κατάλληλα. 

Η µορφή που έχει η φόρµα των γεωγραφικών οντοτήτων παρουσιάζεται στην συνέχεια 
(φόρµα πόλεων): 
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Σχήµα 6.1: Γενική µορφή φόρµας διαχείρισης των οντοτήτων. 

 
Οι λειτουργίες των µενού αναπαράγουν κοινές λειτουργίες των µενού του λογισµικού 
«Υδρογνώµων» (π.χ. menu Windows: Φόρµες για τις διάφορες γεωγραφικές οντότητες ή την 
φόρµα δεδοµένων των χρονοσειρών, Edit: Connect to database /Change database password  
Options). Επιπλέον: 

�� Menu Tools → Go to (Ctrl+G): ∆ίνει την δυνατότητα άµεσης µετάβασης σε κάποια 
γεωγραφική οντότητα όταν είναι γνωστός ο αριθµός ID. 

�� Menu Edit → Copy synoptic table: Αντιγράφεται ο συνοπτικός πίνακας στο clipboard 
ώστε να χρησιµοποιηθεί από εφαρµογές των Windows (π.χ. Excel) 

�� Menu Edit → Show real gentities / synthetic /all: Φιλτράρισµα ώστε να απεικονίζονται 
µόνο οι πραγµατικές γεωγραφικές οντότητες (κατ΄ αρχήν, default, ρύθµιση), µόνο οι 
συνθετικές ή όλες. 

Με χρήση του συνοπτικού πίνακα, είναι εύκολη η µετάβαση σε διαφορετικές γεωγραφικές 
οντότητες: 
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Σχήµα 6.2: Συνοπτικός πίνακας οντοτήτων. 

 
Πατώντας το ποντίκι πάνω στον τίτλο κάποιου πεδίου (π.χ. id, Type, Subtype, όπως στο 
παραπάνω σχήµα), γίνεται αλφαβητική ταξινόµηση. Η δυνατότητα αυτή µάλιστα επιτρέπει 
την ταξινόµηση µε αντίστροφη σειρά αν πατηθεί δύο φορές το ίδιο πεδίο. Επιπλέον, είναι 
δυνατή η ταξινόµηση µε µέχρι τρία κριτήρια αν πατηθούν διαδοχικά τρεις τίτλοι πεδίων. 
Τέλος, µε διπλό κλικ γίνεται µετάβαση πίσω στην κύρια σελίδα (data entry form). 

Κοινά κουµπιά σε φόρµες gentities: 

Time series...: Ανοίγει το παράθυρο για την διαχείριση των χρονοσειρών. 

Events...: Ανοίγει το παράθυρο του ηµερολογίου των γεγονότων. Ο χρήστης µπορεί να 
γράψει ελεύθερα για γεγονότα που συσχετίζονται µε την γεωγραφική οντότητα (π.χ. 
εγκατάσταση νέων καταγραφικών σε έναν σταθµό, βλάβες κλπ). Γεγονότα - Events µπορούν 
να προστεθούν ανεξάρτητα από το editing της εγγραφής της οντότητας. Για να προστεθεί 
κάποια εγγραφή στα events, θα χρησιµοποιείται το κουµπί “Insert” ή το κάτω βελάκι ή 
γράφοντας απευθείας. Για να διαγραφεί κάποια εγγραφή στα events, χρησιµοποιείστε τον 
συνδυασµό πλήκτρων: “Ctrl+Delete”. 

Remarks...: Ο χρήστης γράφει ελεύθερα γενικές σηµειώσεις /σχόλια /διευκρινήσεις. Η 
εισαγωγή σχολίων είναι δυνατή µόνο κατά το editing της εγγραφής της οντότητας. 

Multimedia...: Είναι δυνατή η προβολή υλικού πολυµέσων (σχετικών φωτογραφιών ή βίντεο) 
αν υπάρχουν στην βάση δεδοµένων. Ο χρήστης προσθέτει το δικό του υλικό πολυµέσων 
µέσω της λειτουργίας “Load from file”. 

Show on map...: Εµφανίζεται η θέση της γεωγραφικής οντότητας σε χάρτη, µέσω του 
προγράµµατος “ArcGIS”. 

6.3 Γενικά πεδία - Πλοήγηση στην βάση δεδοµένων - Ειδικά πεδία 
Τα γενικά πεδία παρουσιάζονται στις φόρµες όλων των τύπων γεωγραφικών οντοτήτων: 
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Σχήµα 6.3: Γενικά πεδία οντοτήτων, κουµπιά πλοήγησης στην βάση. 

 
Ο αριθµός “id” είναι ο µοναδικός αριθµός που έχει η γεωγραφική οντότητα ώστε να 
δηµιουργείται αποθήκευση στην βάση δεδοµένων. Ο αριθµός id αποδίδεται αυτόµατα από το 
σύστηµα κατά την δηµιουργία της γεωγραφικής οντότητας και δεν είναι δυνατή η µεταβολή 
µε κανέναν τρόπο. Επιπλέον, κατά την διαγραφή µίας εγγραφής από τις οντότητες, το id που 
είχε η οντότητα δεν ξαναποδίδεται στη βάση δεδοµένων. 

Η επισήµανση “Synthetic” είναι ενεργοποιηµένη µόνο σε συνθετικές οντότητες. Με το 
λογισµικό «Υδρογνώµων» δεν υπάρχει η δυνατότητα δηµιουργίας συνθετικών οντοτήτων 
παρά µόνο η επισκόπηση ή η τροποποίηση. Οι συνθετικές οντότητες που υπάρχουν στην 
βάση παράγονται µε το λογισµικό «Υδρονοµέας». 

Η ονοµασία της γεωγραφικής οντότητας δίνεται στα Ελληνικά και στα Αγγλικά στα πεδία 
“Name” (Greek) (English). Επίσης ορίζεται η ονοµασία του δήµου στα πεδία “Municipality” 
στα ελληνικά (Greek) και στα Αγγλικά (English). 

Από την λίστα Prefecture επιλέγουµε τον νοµό στον οποίο ανήκει η οντότητα. 

Στα πεδία “Location” (Greek) (English) εισάγουµε πιο συγκεκριµένα στοιχεία για την 
τοποθεσία. 

Η πλοήγηση στην βάση δεδοµένων γίνεται χρησιµοποιώντας την παρακάτω διάταξη 
κουµπιών: 

 
Σχήµα 6.4: Κουµπιά πλοήγησης στην βάση δεδοµένων. 

 
Οι λειτουργίες των κουµπιών είναι: 

|< Μετάβαση στην πρώτη εγγραφή. 

< Μετάβαση σε µία εγγραφή πίσω. 

> Μετάβαση σε µία εγγραφή µπροστά. 

>| Μετάβαση στην τελευταία εγγραφή. 

+ ∆ηµιουργία νέας εγγραφής. 

- ∆ιαγραφή κάποιας εγγραφής. 

∆ Τροποποίηση εγγραφής (edit). 

ν Αποστολή τροποποιηµένων ή νέων τιµών (commit). 

X Αναίρεση τυχόν τροποποιήσεων ή νέων τιµών (cancel). 

C Ανανέωση - Refresh. 

Οι γεωγραφικές οντότητες που χαρακτηρίζονται ως επιφάνειες, περιέχουν επιπλέον τα 
παρακάτω ειδικά πεδία: 
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Σχήµα 6.5: Πεδία ιδιοτήτων επιφάνειών. 

 
Ως θέση της οντότητας θεωρείται κάποιο χαρακτηριστικό σηµείο το οποίο µπορεί να είναι 
λ.χ. το κέντρο βάρους (π.χ. για κάποιον ταµιευτήρα). Η θέση αυτή προσδιορίζεται από 
γεωγραφικές (ελλειψοειδείς) συντεταγµένες (φ, λ - phi - lambda / d - m - s δηλαδή µοίρες, 
πρώτα λεπτά, δεύτερα λεπτά) καθώς και επίπεδες - ορθογώνιες συντεταγµένες X Y (π.χ. 
Ε.Γ.Σ.Α. 87) σε µέτρα. 

Το χαρακτηριστικό υψόµετρο (Altitude) είναι συνήθως κάποιο µέσο υψόµετρο (π.χ. µέση 
στάθµη ταµιευτήρα) σε µέτρα. Η επιφάνεια (Area) µπορεί να είναι µέση επιφάνεια 
προκειµένου για ταµιευτήρα ή συνολική επιφάνεια προκειµένου για λεκάνη απορροής και 
λόγω τάξης µεγέθους θα πρέπει να είναι εκφρασµένη σε τετραγωνικά χιλιόµετρα km2. 

Οι γεωγραφικές οντότητες που χαρακτηρίζονται ως σηµεία, περιέχουν τα παραπάνω 
δεδοµένα (επιφάνειας) χωρίς πληροφορία για επιφάνεια (Area): 

 
Σχήµα 6.6: Πεδία ιδιοτήτων σηµείων 

 
Οι γεωγραφικές οντότητες που χαρακτηρίζονται ως γραµµές (τέτοιες είναι µόνο τα τµήµατα 
υδραγωγείου) θα περιέχουν ότι και τα σηµεία και κάποια πεδία επιπλέον: 

 
Σχήµα 6.7: Πεδία ιδιοτήτων γραµµών 

 
Στο τύπο γραµµών καθορίζονται συντεταγµένες αρχής και τέλους (Start /End coordinates), 
καθώς και το µήκος της γραµµής σε χιλιόµετρα. 

Οι γεωγραφικές οντότητες που χαρακτηρίζονται ως δίκτυα (τέτοιες είναι µόνο τα 
υδραγωγεία), περιέχουν µόνο βασικά χαρακτηριστικά (Ονοµασία). 

6.4 Μετρητικοί σταθµοί (Stations) 
Οι µετρητικοί σταθµοί είναι οντότητα µε ιδιότητες σηµείου (πρέπει να προδιαγραφεί η θέση, 
οριζοντιογραφικά και υψοµετρικά). 

Στην κατηγορία των µετρητικών σταθµών υπάγονται: 

��Μετεωρολογικοί σταθµοί 
��Υδροµετρικοί σταθµοί 

Η πρώτη κατηγορία αφορά σταθµούς µέτρησης µετεωρολογικών δεδοµένων όπως 
θερµοκρασία, υγρασία, βροχόπτωση, ηλιακή ακτινοβολία, κ.α. Η δεύτερη κατηγορία αφορά 
σταθµούς µέτρησης υδρολογικών δεδοµένων όπως στάθµη ταµιευτήρα, στάθµη ρέµατος µε 
παράλληλες µετρήσεις στάθµης παροχής κ.α. 

Η εµφάνιση της φόρµας των µετρητικών σταθµών απεικονίζεται στο παρακάτω σχήµα: 
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Σχήµα 6.8: Φόρµα µετρητικών σταθµών. 

 
Στις τρεις λίστες επιλογής: “Services, Type, Subtype”, καθορίζονται: 

Service: Ο φορέας λειτουργίας του σταθµού (ΥΠΕΧΩ∆Ε, ΕΜΥ, ΕΥ∆ΑΠ κλπ) 

Type: Ο τύπος του σταθµού (Μετεωρολογικός, Υδροµετρικός) 

Subtype: ∆ευτερεύουσα κατηγοριοποίηση των σταθµών (Συνοπτικός, Γεωργικός, 
Κλιµατολογικός, Αεροναυτικός) 

Στα πεδία “Various codes” µπορούν να εισαχθούν οι κωδικοί αριθµοί του σταθµού, στα πεδία 
Functioning period οι ηµεροµηνίες λειτουργίας του σταθµού. Επιπλέον µπορούν να 
επισηµανθεί αν ένας σταθµός είναι ενεργός (Active) ή Τηλεµετρικός (Telemetric). 

Με πίεση των κουµπιών “Instruments, Loggers” ανοίγουν οι φόρµες διαχείρισης των 
οργάνων και των καταγραφέων. Τα όργανα και οι καταγραφείς είναι «υποοντότητες» που δεν 
έχουν γεωγραφικό χαρακτήρα αλλά ανήκουν στην γεωγραφική οντότητα των µετρητικών 
σταθµών. 

 
Σχήµα 6.9: Φόρµα οργάνων (Instruments). 
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Σε κάθε όργανο µπορούν να ανήκουν χρονοσειρές οι οποίες φυσικά κληρονοµούνται από τον 
µητρικό σταθµό. Επιπλέον καθορίζεται ο τύπος της συσκευής (Type), καθώς και λοιπά 
στοιχεία (κατασκευαστής - manufacturer, µοντέλο - model). Στο πεδίο ο χρήστης µπορεί να 
ανακαλέσει το κατάλληλο εγχειρίδιο οδηγιών για τον συγκεκριµένο τύπο συσκευής. 

 
Σχήµα 6.10: Φόρµα καταγραφέων (Loggers). 

 
Παρόµοια πεδία µε τα όργανα περιέχονται και στους καταγραφείς (τύπος, µοντέλο κλπ). 

6.4.1 Υδροµετρικοί σταθµοί 
Οι υδροµετρικοί σταθµοί είναι µετρητικοί σταθµοί όπου µετράνε υδροµετρικά δεδοµένα. Η 
φόρµα των υδροµετρικών σταθµών διαφοροποιείται ελάχιστα από αυτήν των 
µετεωρολογικών: 

 
Σχήµα 6.11: Υδροµετρικός σταθµός (Πόρος Ρηγανίου). 
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Οι επιπλέον λειτουργίες που παρέχονται στην φόρµα των υδροµετρικών αφορούν στην 
εισαγωγή καµπυλών Στάθµης- Παροχής (Stage-Discharge) και Στάθµης- Στερεοπαροχής 
(Stage-Sedim. Discharge). 

Πατώντας κάποιο από τα κουµπιά Stage-Discharge ή Discharge-Sediment Discharge., ανοίγει 
η φόρµα διαχείρισης των καµπυλών: 

 
Σχήµα 6.12: Καµπύλες στάθµης παροχής (αριθµητικά δεδοµένα). 

 
Με τα κουµπιά πλοήγησης της βάσης (<> + - ν Χ) µπορούµε να προσθέσουµε, να 
διαγράψουµε ή να ανακαλέσουµε κάποια οµάδα (συλλογή) καµπυλών στάθµης παροχής. Η 
κάθε οµάδα καµπυλών περιέχει µία συλλογή καµπυλών, όπου κάθε καµπύλη έχει: 

Ιδιότητα ως καµπύλη επέκτασης (Is extension) 

Μετατόπιση υψοµετρικής αφετηρίας στάθµης (Offset) 

Χρονικό διάστηµα εγκυρότητας της καµπύλης Start date, End date. 

Η καµπύλη µπορεί να προστεθεί στον πίνακα καµπύλων µε το πλήκτρο Insert ή µε το 
πλήκτρο του κάτω βέλους (Down arrow). Για να διαγραφεί κάποια καµπύλη του σετ 
χρησιµοποιείται ο συνδυασµός πλήκτρων “Ctrl+Delete”. 

Πατώντας το κουµπί Points ανοίγει ένας πίνακας όπου θα ορίσετε τα σηµεία κάποιας από της 
καµπύλης του σετ. Παροµοίως, µε τα πλήκτρα Insert/ Ctrl+Delete εισάγονται / διαγράφονται 
σηµεία. 

6.5 Ταµιευτήρες (Reservoirs) 
Η οντότητα «ταµιευτήρες» αφορά σε τεχνητές ή φυσικές λίµνες που προσφέρουν το υδατικό 
τους απόθεµα για τις ανάγκες ύδρευσης ή άρδευσης. Η οντότητα «ταµιευτήρας» ανήκει στην 
κατηγορία των επιφανειακών οντοτήτων και περιγράφεται από µία χαρακτηριστική θέση (π.χ. 
γεωµετρικό κέντρο της επιφάνειας) καθώς και από την µέση επιφάνεια της λίµνης (καθώς η 
επιφάνεια έχει εποχιακές διακυµάνσεις αφού είναι άµεση συνάρτηση της στάθµης). 
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Η φόρµα για την διαχείριση των ταµιευτήρων παρουσιάζεται στην συνέχεια: 

 
Σχήµα 6.13: Φόρµα για τους ταµιευτήρες. 

 
Με το κουµπί “Stage-Area-Volume” ενεργοποιείται η φόρµα διαχείρισης καµπύλων στάθµης 
- επιφάνειας, αποθέµατος ταµιευτήρα: 

 
Σχήµα 6.14: Καµπύλες στάθµης - αποθέµατος, επιφάνειας (αριθµητικά δεδοµένα). 
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Με τα κουµπιά πλοήγησης στην βάση (< > + - ν Χ) είναι δυνατή η εισαγωγή νέων καµπυλών 
ή η διαγραφή τους. 

Για να εισαχθεί κάποια εγγραφή στον πίνακα των καµπυλών, γίνεται χρήση του πλήκτρου 
“Insert” ή το κάτω βέλος, ενώ για να διαγραφεί κάποια εγγραφή χρησιµοποιείται ο 
συνδυασµός πλήκτρων: “Ctrl+Delete”. 

Κάθε εγγραφή (σηµείου) καµπύλης περιέχει: 

S/N: αριθµός σηµείου που αποδίδεται αυτόµατα από την Βάση ∆εδοµένων. 

Type: τύπος σηµείου που µπορεί να οριστεί από µία λίστα προεπιλεγµένων τιµών: «Κατώτατη 
στάθµη υδροληψίας, κατώτατη στάθµη λειτουργίας, ανώτατη στάθµη υπερχείλισης, Άλλη, 
κ.α.». 

Stage: είναι η στάθµη σε µέτρα. 

Area : η επιφάνεια σε τετραγωνικά χιλιόµετρα [km2]. 

Volume: ο όγκος σε εκατοµµύρια κυβικά µέτρα [hm3]. 

Bank length: το µήκος της ακτογραµµής σε χιλιόµετρα [km]. 

Πατώντας το κουµπί “Leakage coefficients” ενεργοποιείται η φόρµα για την διαχείριση των 
παραµέτρων που αφορούν τις υπόγειες διαφυγές ταµιευτήρα: 

 
Σχήµα 6.15: Καµπύλη στάθµης διαφυγών ταµιευτήρα (αριθµητικά δεδοµένα). 

 
Η εισαγωγή των εγγραφών γίνεται µε τα πλήκτρα που αναφέρονται στην προηγούµενη 
παράγραφο, για την εισαγωγή σηµείων στις καµπύλες στάθµης όγκου. Στην περίπτωση των 
καµπύλων διαφυγών εισάγονται τα εξής στοιχεία: 

Month: µήνας. Οι τιµές των παραµέτρων διαφυγής έχουν εποχιακή διακύµανση και µάλιστα 
έχει παρατηρηθεί ένας ετήσιος κύκλος. 
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a,b,c,e: συντελεστές πολυωνύµου που υπολογίζει τις υπόγειες διαφυγές σε εκατοµµύρια 
κυβικά µέτρα τον µήνα. Το e αφορά τον σταθερό όρο ενώ c,b,a είναι οι συντελεστές του 
πρωτοβάθµιου, δευτεροβάθµιου και τριτοβάθµιου όρου. Η δε παράµετρος του πολυωνύµου 
είναι η στάθµη του ταµιευτήρα σε µέτρα. 

sigma: η τυπική απόκλιση στον προσδιορισµό των υπόγειων διαφυγών για τον συγκεκριµένο 
µήνα. 

Πατώντας το πλήκτρο “Reservoir Balance” ενεργοποιείται η φόρµα για τον υπολογισµό του 
ισοζυγίου ταµιευτήρα. Αν η φόρµα είναι ήδη ενεργοποιηµένη, θα φορτωθούν τα δεδοµένα 
του τρέχοντος ταµιευτήρα. 

6.6 Πόλεις (Cities) 
Η πόλη ως οντότητα θεωρείται σηµείο. Εισάγονται τα γενικά στοιχεία των οντοτήτων καθώς 
και ο κωδικός της πόλης κατά ΕΣΥΕ. 

 
Σχήµα 6.16: Φόρµα για τις πόλεις. 

 

6.7 Φράγµατα (Dams) 
Τα φράγµατα θεωρούνται σηµειακές οντότητες. Η φόρµα διαχείρισης των φραγµάτων είναι η 
παρακάτω: 
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Σχήµα 6.17: Φόρµα για τα φράγµατα. 

 
Επιπλέον εισάγονται διάφορες κατασκευαστικές και υδραυλικές παράµετροι του φράγµατος: 

Height: το ύψος του φράγµατος (από τον πόδα έως την στέψη). 

Crest altitude: το υψόµετρο της στέψης του φράγµατος 

Crest length, width: Μήκος και πλάτος της στέψης σε µέτρα. 

Face slope upstream / downstream: Η κλίση των πρανών ανάντη και κατάντη (αντίστροφο 
κλάσµα π.χ. η τιµή 2 σηµαίνει κλίση 1 ύψος προς 2 µήκος ή 50%). 

Spillway description: Μία λεκτική περιγραφή του τύπου του υπερχειλιστή. 

Spillway discharge: H παροχετευτικότητα του υπερχειλιστή. 

Πατώντας το κουµπί “Spillway stage-discharge curve” είναι δυνατή η διαχείριση των 
καµπυλών στάθµης παροχής του υπερχειλιστή µέσω της παρακάτω φόρµας: 

 
Σχήµα 6.18: Τιµές στάθµης παροχής υπερχειλιστή φράγµατος. 
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6.8 Λεκάνες απορροής (Basins) 
Οι λεκάνες απορροής είναι επιφανειακές οντότητες στις οποίες ισχύει η αναδροµή, δηλαδή 
κάποια λεκάνη απορροής µπορεί να είναι µία υπολεκάνη κάποιας ευρύτερης λεκάνης 
απορροής. Η διαχείριση των λεκανών γίνεται µε χρήση της παρακάτω φόρµας: 

 
Σχήµα 6.19: Φόρµα για τις λεκάνες απορροής. 

 
Στην λίστα Parent Basin µπορεί να καθοριστεί η «µητρική» λεκάνη απορροής. Η µητρική 
λεκάνη απορροής πρέπει να είναι κάποια λεκάνη η οποία δεν εντάσσεται σε κάποια ανώτερη 
λεκάνη. ∆εν επιτρέπεται δηλαδή η άπειρη αναδροµή παρά µόνο η πρώτου βαθµού συγγένεια. 
Για να καταργηθεί η συγγένεια, θα πρέπει στην λίστα µητρικών λεκανών να χρησιµοποιηθεί 
το πλήκτρο “Delete”. 

6.9 ∆ιυλιστήρια (Treatment plans) 
Τα διυλιστήρια αποτελούν σηµειακές οντότητες. 
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Σχήµα 6.20: Φόρµα για τα διυλιστήρια. 

 
Οι τιµές που µπορούν να εισαχθούν στα κατάλληλα πεδία είναι: 

Capacity: Μέση διυλιστική ικανότητα σε κυβικά µέτρα την ηµέρα. 

Peak capacity: Μέγιστη ηµερήσια διυλιστική ικανότητα. 

Outlet level: Στάθµη εξόδου (m). 

Overflow stage: Στάθµη υπερχείλισης (m) 

Storage: Αποθηκευτική ικανότητα σε κυβικά µέτρα. 

6.10 Αντλίες - Γεννήτριες (Pump - Generators) 
Οι αντλίες και οι γεννήτριες είναι σηµειακές οντότητες και εντάσσονται στην κατηγορία 
«µετατροπείς ενέργειας». Η διαχείρισή τους γίνεται µέσω της παρακάτω φόρµας: 
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Σχήµα 6.21: Αντλίες - γεννήτριες. 

 
Μέσω της κατάλληλης επισήµανσης καθορίζεται αν η οντότητα θα είναι: 

Irrigation point - Σηµείο άρδευσης (µπορεί να τεθεί σε συνδυασµό µε την επισήµανση 
αντλίας, αν όχι έχουµε σηµείο άρδευσης µε βαρύτητα). 

Pump - Αντλία. 

Generator - Γεννήτρια (ο µετατροπέας ενέργειας µπορεί να είναι ταυτόχρονα αντλία και 
γεννήτρια). 

Αν η αντλία / γεννήτρια είναι ενεργή, χρησιµοποιούµε την επισήµανση “Active”. 

Στο πεδίο “Total power” καθορίζεται η εγκατεστηµένη ισχύς του µετατροπέα ενέργειας, στο 
πεδίο “Number of generators / pumps” ο αριθµός των γεννητριών / αντλιών, “Generator / 
Pump discharge” η απαιτούµενη παροχή της γεννήτριας / αντλίας και “Generator / Pump 
energy” η ενέργεια γεννήτριας / αντλίας. Στην λίστα “Pump type” καθορίζεται ο τύπος της 
αντλίας. 

Πατώντας το κουµπί “Pump-generator discharge” ανοίγει µία φόρµα στον πίνακα της οποίας 
µπορεί να οριστούν καµπύλες ύψους - πτώσης παροχής που αφορούν στον συγκεκριµένο 
µετατροπέα ενέργειας. 

6.11 Γεωτρήσεις - πηγές (Boreholes - springs) 
Οι γεωτρήσεις καθώς και οι πηγές οι οποίες µοιράζονται κοινά χαρακτηριστικά ανήκουν στην 
γενικότερη κατηγορία των σηµειακών οντοτήτων. Συγκεκριµένα η γεώτρηση είναι ο πιο 
γενικευµένος τύπος ενώ τα χαρακτηριστικά της πηγής είναι ένα υποσύνολο των 
χαρακτηριστικών της γεώτρησης. Κατά συνέπεια η φόρµα διαχείρισης της πηγής είναι µία 
«περιληπτική» φόρµα γεωτρήσεων, οι δύο αυτές φόρµες απεικονίζονται παρακάτω: 
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Σχήµα 6.22: Φόρµα για τις γεωτρήσεις (Boreholes). 

 

 
Σχήµα 6.23: Φόρµα για τις πηγές. 

 
Οι λίστες επιλογής που παρέχονται είναι: 

Water use: χρήση ύδατος, µεταξύ: «Βιοµηχανική, άρδευση, Ύδρευση, κλπ». 

Water user: ο χρήστης του ύδατος: «∆ήµος, τουριστική µονάδα, ιδιώτης, κτηνοτροφική 
µονάδα». 

Land user: χρήση γης: «Γεωργική, δάσος, οικισµός, βοσκότοπος». 

Geological types (µόνο στις πηγές): γεωλογικό υπόβαθρο όπως: «Καρστικό, ιζηµατογενές, 
βραχώδες». 

Spring type (µόνο στις πηγές): είδος πηγής όπως: «Υπερχείλισης, καρστική, ιαµατική κλπ». 

Drill type (µόνος στις γεωτρήσεις): είδος διάτρησης (γεωτρύπανου), «Υδραυλικό, µηχανικό, 
αερόσφυρα». 
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Pressure meter (µόνο στις γεωτρήσεις): είναι δυνατή η εγκατάσταση πιεσόµετρου επί της 
γεωτρήσεως. Σε µία τέτοια περίπτωση πρέπει να είναι ενεργοποιηµένο (επισήµανση Exists) 
να καθοριστεί ο τύπος (type) από «Ελεύθερο ή κολλητό» καθώς και η διάµετρος (diameter) 
και το µήκος (length). 

Στις γεωτρήσεις µπορούν να καθοριστούν προαιρετικά οι παρακάτω τιµές: 

Discharge: Παροχή: test (δοκιµής), Exploit. (εκµετάλλευσης). 

Drawn down: Πτώσης στάθµης: test (δοκιµής), Exploit. (εκµετάλλευσης). 

Water level: Στάθµη ύδατος (ΣΥΥ). 

Construction date: χρονική περίοδος κατασκευής 

Parameters t, s, b, k: παράµετροι t, s, b, k 

Χρησιµοποιώντας τα κουµπιά “Hole, Pipe, Permeable layers, Lithological section”, ανοίγουν 
φόρµες µε πίνακες γίνεται η εισαγωγή της γεωµετρικής περιγραφής τους: 

Οπές (hole), γεωµετρική περιγραφή κατά βάθος (στάθµη - διάµετρος οπής). 

Σωλήνες (pipe), γεωµετρική περιγραφή κατά βάθος (στάθµη - διάµετρος σωλήνα, πάχος, 
υλικό, φίλτρο). 

Περατά στρώµατα (permeable layers), γεωµετρική περιγραφή κατά βάθος, πάχος στρώµατος. 

Γεωλογική τοµή (lithological section), γεωλογικά στρώµατα κατά βάθος (πάχος στρωµάτων, 
λιθολογική σύσταση, χρώµα, γεωλογική ηλικία κ.α.). 

6.12 Υδραγωγεία - τµήµατα υδραγωγείων (Aqueducts, aqueducts 
segments) 

Τα υδραγωγεία αποτελούν το µοναδικό είδος οντότητας - δικτύου (network). Ένα δίκτυο 
αποτελείται στην συνέχεια από τµήµατα (segments) τα οποία είναι γραµµικές οντότητες. 
Συγκεκριµένα τα υδραγωγεία αποτελούνται από τµήµατα υδραγωγείων (aqueduct segments). 

 
Σχήµα 6.24: Φόρµα για τα υδραγωγεία (ως δίκτυα που αποτελούνται από τµήµατα 

υδραγωγείων). 
 
Στην συνέχεια αν πατηθεί το κουµπί “Segments” θα εµφανιστούν τα τµήµατα του παραπάνω 
υδραγωγείου: 
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Σχήµα 6.25: Φόρµα για τα τµήµατα υδραγωγείου. 

 
Όπως µπορούµε να παρατηρήσουµε στον επόµενο συνοπτικό πίνακα, το υδραγωγείο 
«Υδραγωγείο Μόρνου» µε id=184, αποτελείται από διάφορα τµήµατα: 

 
Σχήµα 6.26: Συνοπτικός πίνακας µε τµήµατα υδραγωγείου ενός ευρύτερου υδραγωγείου. 

 
Χρησιµοποιώντας τις λίστες επιλογής της φόρµας µπορούν να µεταβληθούν: 

Type: τύπος αγωγού: «Σήραγγα, σίφωνας, διώρυγα, κ.α.». 
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Flow type: καθεστώς ροής: «Ροή µε ελεύθερη επιφάνεια, ροή υπό πίεση». 

Status: κατάσταση: «Υπό κατασκευή ή Σε λειτουργία». 

Ειδικές τιµές µπορούν να εισαχθούν στα παρακάτω πεδία: 

Discharge: Παροχή. 

Start and end position: Χιλιοµέτρηση αρχής και τέλους αγωγού στο σύνολο του υδραγωγείου. 

Surface / bottom slope: Κλίση επιφάνειας και πυθµένα. 

Repers: Υψοµετρικές αφετηρίες. 

Stage is measured: Επισήµανση: Η στάθµη µετριέται. 

Discharge is measured: Επισήµανση: Η παροχή µετριέται. 

Αν πατήσετε το κουπί “Head-discharge curves” ανοίγει µία φόρµα όπου µπορεί να 
περιγραφτεί σε έναν πίνακα η καµπύλη παροχετευτικότητας του υδραγωγείου. 

Στην λίστα “Cross section” επιλέγεται η διατοµή του υδραγωγείου. Η διαχείριση των 
διατοµών γίνεται πατώντας το κουµπί “Cross sections” οπότε και θα ανοίξει η παρακάτω 
φόρµα όπου µπορούν να περιγραφούν οι διατοµές καθώς και να εισαχθούν τα σχήµατά τους 
(µε copy - paste από εξωτερική εφαρµογή). 

 
Σχήµα 6.27: ∆ιατοµές υδραγωγείου. 
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7 Ισοζύγια ταµιευτήρων 

7.1 Γενικά για τα ισοζύγια ταµιευτήρων 
Η φόρµα του ισοζυγίου ταµιευτήρων δίνει την δυνατότητα στον χρήστη του λογισµικού 
«Υδρογνώµων», να κάνει έµµεσες εκτιµήσεις για άγνωστα µεγέθη (χρονοσειρές) 
ταµιευτήρων σύµφωνα µε την οµώνυµη µεθοδολογία. 

Το αποτέλεσµα της επεξεργασίας είναι µία νέα χρονοσειρά η οποία είναι: 

��Είτε µία χρονοσειρά εισροής όταν το άγνωστο µέγεθος είναι για παράδειγµα. η απορροή 
στον ταµιευτήρα 

��Είτε µία χρονοσειρά εκροής όταν το άγνωστο µέγεθος είναι για παράδειγµα οι υπόγειες 
απώλειες ή η εξάτµιση κλπ 

Με την χρήση του ισοζυγίου ταµιευτήρων είναι δυνατός ο υπολογισµός των παρακάτω 
άγνωστων µεγεθών που αφορούν τους ταµιευτήρες του υδροδοτικού συστήµατος της 
Αθήνας: 

��Απορροή για τους ταµιευτήρες του Μόρνου, του Ευήνου και του Μαραθώνα (εισροή) 
��Υπόγειες διαφυγές για τον ταµιευτήρα της Υλίκης (εκροή). 

Τα συνήθη δεδοµένα (χρονοσειρές) για την επίλυση του προβλήµατος είναι: 

��Απόθεµα και επιφάνεια ταµιευτήρα όπως προκύπτει από την µέτρηση της στάθµης του 
ταµιευτήρα και εφαρµόζοντας στην συνέχεια καµπύλες στάθµης – αποθέµατος, 
επιφάνειας. 

��Βροχόπτωση, µετρηµένη από µετρητικό σταθµό µε γεωγραφική συσχέτιση µε τον 
ταµιευτήρα. 

��Εξάτµιση, εκτίµηση ύψους εξάτµισης από µετεωρολογικά δεδοµένα σύµφωνα µε την 
µέθοδο Penman ή άλλη αποδεκτή µεθοδολογία. 

��Απολήψεις, π.χ. για υδροδότηση ή για άρδευση. 
��Απώλειες, από υπερχειλίσεις, υπόγειες διαφυγές, απώλειες υδραγωγείου κ.α. 
��Εισροές από υδραγωγείο. Η εκτίµηση της εισροής µπορεί να γίνεται µε χρήση καµπύλων 

στάθµης παροχής. 

7.2 Ενεργοποίηση φόρµας 
Η ενεργοποίηση της φόρµας Ισοζυγίου Ταµιευτήρων, είναι δυνατή µέσω της φόρµας 
ταµιευτήρων (Reservoirs) πατώντας το αντίστοιχο κουµπί (Reservoir Balance). 
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Σχήµα 7.1: Ενεργοποίηση της φόρµας υπολογισµού των ισοζυγίων από την φόρµα των 

ταµιευτήρων. 
 
Στην συνέχεια ανοίγει η φόρµα του Ισοζυγίου Ταµιευτήρων σύµφωνα µε το αριθµό ID του 
ταµιευτήρα της φόρµας ταµιευτήρων. Αφού ενεργοποιηθεί η φόρµα του Ισοζυγίου, όλοι οι 
υπολογισµοί θα αναφέρονται σε αυτό το ID. 

Η φόρµα του ισοζυγίου διατηρεί τις παραµέτρους που είχε εισάγει ο χρήστης την 
προηγούµενη φορά που την χρησιµοποίησε για το συγκεκριµένο ID ταµιευτήρα. 

Οι ρυθµίσεις (παράµετροι), αποθηκεύονται στο αρχείο: 
%USERPROFILE%\Application Data\Hydrognomon\ReservoirBalance\id.txt όπου το id 
είναι ο αριθµός ID του ταµιευτήρα ενώ ο κατάλογος %USERPROFILE% αναφέρεται στον 
κατάλογο χρήστη, π.χ. C:\Documents and Settings\user\ 

7.3 Λειτουργίες φόρµας Ισοζυγίου Ταµιευτήρων (Reservoir Balance) 

 
Σχήµα 7.2: Λειτουργίες της φόρµας για τον υπολογισµό του ισοζυγίου ταµιευτήρων. 

 
Η φόρµα του Ισοζυγίου Ταµιευτήρων αποτελείται από πεδία εισαγωγής παραµέτρων (ID 
χρονοσειρών, επιφάνειες), επισηµάνσεις (χρήση µέσης επιφάνειας, επισήµανση 
αποτελεσµάτων ως απορροή, συνέπεια ηµεροµηνιών έναρξης και λήξης υπολογισµών), 
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λίστας των χρονοσειρών ισοζυγίου, καθώς και των κουµπιών για την επικύρωση των 
χρονοσειρών και την εκτέλεση υπολογισµών. 

7.3.1 Στοιχεία ταµιευτήρα 
Παρουσιάζονται τα στοιχεία του ταµιευτήρα (αριθµός ID, ονοµασία). Τα στοιχεία αυτά 
προέρχονται από την φόρµα του ταµιευτήρα από την οποία εκλήθη η φόρµα του ισοζυγίου. 

7.3.2 Τοµέας αποτελεσµάτων 

 
Σχήµα 7.3: Στοιχεία αποτελεσµάτων. 

 
Ο χρήστης καθορίζει το ID της χρονοσειράς όπου θα αποθηκευτούν τα αποτελέσµατα. Ο 
υπολογισµός δεν µπορεί να πραγµατοποιηθεί αν προηγουµένως ο χρήστης δεν έχει καθορίσει 
ένα έγκυρο ID για τα αποτελέσµατα. Στην συνέχεια καθορίζεται αν το αποτέλεσµα είναι 
εισροή (inflow) ή εκροή (outflow). Τέλος επισηµαίνοντας την επιλογή “Result is Runoff”, 
θέτουµε το αποτέλεσµα ως απορροή ώστε να είναι δυνατός ο υπολογισµός του ύψους 
απορροής της υπολεκάνης. Θέτοντας το αποτέλεσµα ως απορροή, ακυρώνεται η επιλογή να 
χρησιµοποιούνται οι επιλεγµένες από τον χρήστη: «χρονοσειρές εισαγωγής ως χρονοσειρές 
απορροών». 

7.3.3 Στοιχεία λεκάνης απορροής 

 
Σχήµα 7.4: Στοιχεία λεκάνης απορροής. 

 
Ο χρήστης πρέπει να εισάγει την επιφάνεια της λεκάνης απορροής (Basin Area σε km2) 
καθώς και το ID της χρονοσειράς όπου θα αποθηκευτεί το ύψος απορροής, ώστε να είναι 
δυνατός ο υπολογισµός του. 

7.3.4 Ηµεροµηνίες υπολογισµών/ συνέπεια 

 
Σχήµα 7.5: Χρόνοι υπολογισµών. 

 
Αφού γίνει η επικύρωση των χρονοσειρών, στα πεδία “Result TS from:” και “to:” 
εµφανίζεται το χρονικό διάστηµα για το οποίο θα γίνουν οι υπολογισµοί του Ισοζυγίου 
Ταµιευτήρων. Το χρονικό διάστηµα υπολογίζεται αυτόµατα. 

Ο χρήστης µπορεί να καθορίσει µέσω των επισηµάνσεων “Consistent Start Dates” και 
“Consistent End Dates” την συνέπεια µεταξύ των χρονικών διαστηµάτων των χρονοσειρών 
εισαγωγής. Όταν π.χ. είναι ενεργοποιηµένη η επιλογή “Consistent Start Dates”, η ηµεροµηνία 
εκκίνησης της χρονοσειράς αποτελεσµάτων, πρέπει να περιέχεται στα χρονικά διαστήµατα 
όλων των κλάσεων χρονοσειρών εισόδου (ως κλάσεις θεωρούνται οι χρονοσειρές 
βροχόπτωσης, όγκου, επιφάνειας, εξάτµισης, υπόγειων διαφυγών ενώ οι ανεξάρτητες 
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χρονοσειρές εκροής ή εισροής είναι κάθε µία µόνη της µία κλάση). Όταν η επιλογή είναι 
απενεργοποιηµένη, η ηµεροµηνία εκκίνησης είναι η προγενέστερη των ηµεροµηνιών 
εκκίνησης όλων των χρονοσειρών εισόδου. 

Ωστόσο οι κλάσεις χρονοσειρών επιφάνειας και όγκου, είναι πάντα συνεπείς µε το 
αποτέλεσµα. 

7.3.5 Μέση επιφάνεια 

 
Σχήµα 7.6: Επιλογή χρήσης µέσης επιφάνειας. 

 
Όταν είναι ενεργοποιηµένη η επισήµανση “Use Mean Area”, ως επιφάνεια για τους 
υπολογισµούς (όγκου βροχόπτωσης κλπ), λαµβάνεται η µέση τιµή των επιφανειών στην αρχή 
και στο τέλος του χρονικού διαστήµατος υπολογισµού. Η χρήση αυτής της επιλογής έχει 
νόηµα µόνο όταν η χρονοσειρά επιφανειών αποτελείται από τιµές στην αρχή του µήνα. Όταν 
εισάγεται χρονοσειρά µέσων επιφανειών δεν πρέπει να γίνεται περαιτέρω εξοµάλυνση µέσω 
της παραπάνω επιλογής. 

 

7.4 Υπολογισµός ισοζυγίου 

 
Σχήµα 7.7: Κουµπί για την διενέργεια των υπολογισµών. 

 
Ο υπολογισµός γίνεται κατόπιν απαίτησης του χρήστη, πατώντας το κουµπί “Calculate”. Ο 
υπολογισµός εκτελείται µόνο όταν ο χρήστης έχει εισάγει ένα έγκυρο ID για την χρονοσειρά 
αποτελεσµάτων. Επιπλέον, αν έχει εισαχθεί ένα έγκυρο ID για την χρονοσειρά υψών 
απορροής καθώς και η τιµή επιφάνειας της λεκάνης απορροής, επιχειρείται ο υπολογισµός 
του ύψους απορροής. 

Κατόπιν του ελέγχου εισαγωγής έγκυρου ID αποτελεσµάτων, γίνεται η διαδικασία 
επικύρωσης των χρονοσειρών εισόδου. Αν είναι δυνατή η φόρτωση τουλάχιστον µίας 
χρονοσειράς, γίνονται οι γραµµικοί υπολογισµοί και οι αποθήκευση των αποτελεσµάτων 
στην χρονοσειρά αποτελεσµάτων. 

Οι χρονοσειρές είναι κατά προτίµηση µηνιαίου βήµατος. Ωστόσο είναι δυνατή η φόρτωση 
χρονοσειρών µικρότερου χρονικού βήµατος. Σε αυτήν την περίπτωση ο χρήστης έχει 
καθορίσει στις ιδιότητες των χρονοσειρών αν θα γίνεται συνάθροιση όλων των τιµών (π.χ. 
ηµερήσιες τιµές βροχόπτωσης) ή θα λαµβάνεται οι τιµές οι πλησιέστερες στην αρχή κάθε 
µήνα. 

Στο πέρας της διαδικασίας υπολογισµού, εµφανίζονται σε πίνακα οι τιµές υπολογισµού του 
ισοζυγίου σε εκατοµµύρια κυβικά µέτρα. Με τον τρόπο αυτό είναι δυνατόν να εντοπισθούν 
τυχόν κενά και ελλείπουσες τιµές. Επιπλέον είναι δυνατή η αντιγραφή (copy) του πίνακα σε 
εξωτερικό έγγραφο. Ο πίνακας απεικονίζεται παρακάτω: 
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Σχήµα 7.8: Πίνακας αποτελεσµάτων ισοζυγίου ταµιευτήρων. 

7.5 Επικύρωση χρονοσειρών 
Η διαδικασία της επικύρωσης χρονοσειρών γίνεται µε σκοπό την διατήρηση των έγκυρων 
χρονοσειρών για τους υπολογισµούς καθώς και τον υπολογισµό των έγκυρων ηµεροµηνιών. 

Στην περίπτωση που ο χρήστης έχει εισάγει µη έγκυρα ID χρονοσειρών (όπως ID που δεν 
υπάρχουν στην βάση δεδοµένων), γίνεται επισήµανση στον χρήστη και ακολουθεί 
αποµάκρυνση αυτών των χρονοσειρών από την λίστα χρονοσειρών. 

Στην συνέχεια αφού φορτωθούν οι χρονοσειρές γίνεται ταξινόµηση σε κλάσεις ώστε να 
καθοριστούν οι ηµεροµηνίες έναρξης και λήξης. 

Εάν υπάρχουν δύο ή παραπάνω χρονοσειρές στην ίδια κλάση (π.χ. δύο ή παραπάνω 
χρονοσειρές βροχόπτωσης), στην περίπτωση που υπάρχουν επικαλυπτόµενα χρονικά 
διαστήµατα µεταξύ των χρονοσειρών, οι υπολογισµοί γίνονται κατά προτεραιότητα και τυχόν 
κενά σε χρονοσειρά µεγαλύτερης ισχύος συµπληρώνονται από χρονοσειρά µικρότερης 
ισχύος. 

Η επικύρωση γίνεται: 

��Όταν ο χρήστης ζητήσει υπολογισµό 
��Όταν ο χρήστης ζητήσει επικύρωση µε πάτηµα του κουµπιού “Validate TS” 
��Κάθε φορά που κλείνει η φόρµα του Ισοζυγίου, γίνεται επικύρωση πριν αποθηκευτούν οι 

ρυθµίσεις 

7.6 Επικύρωση χρονοσειρών κατ’ απαίτηση του χρήστη 
Ο χρήστης µπορεί να ζητήσει επικύρωση των χρονοσειρών πατώντας το κουµπί: 

 
Σχήµα 7.9: Κουµπί επικύρωσης χρονοσειρών κατ΄ απαίτηση του χρήστη. 

 
Αφού γίνει η διαδικασία της επικύρωσης, εµφανίζεται πίνακας µε τις έγκυρες χρονοσειρές 
που θα χρησιµοποιηθούν στο Ισοζύγιο. Παρουσιάζονται ο τύπος της χρονοσειράς (inflow, 
outflow, rainfall, κλπ), οι ηµεροµηνίες της πρώτης και τελευταίας εγγραφής της χρονοσειράς 
καθώς, ο πολλαπλασιαστικός συντελεστής και οι ηµεροµηνίες εγκυρότητας της χρονοσειράς, 
βάση των οποίων θα υπολογιστεί το ισοζύγιο. 
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Σχήµα 7.10: Απεικόνιση χρονοσειρών µετά την επικύρωσή τους. 

 
Με πάτηµα του κουµπιού “Hide”, κρύβεται ο πίνακας και επανεµφανίζονται τα πεδία 
εισαγωγής της φόρµας. Με το κουµπί “Copy to Clipboard” αντιγράφεται ο πίνακας ώστε να 
µπορεί να επικολληθεί σε µία εφαρµογή όπως το Microsoft Excel. 

7.7 Λίστα χρονοσειρών ισοζυγίου 

 
Σχήµα 7.11: Λίστα χρονοσειρών ισοζυγίου. 

 
Ο χρήστης εισάγει χρονοσειρές στο Ισοζύγιο µε την λειτουργία “Add”. Πίεση του κουµπιού 
“Add” προκαλεί την εισαγωγή στην λίστα χρονοσειράς µε τα στοιχεία που έχουν εισαχθεί 
στα πεδία ID, Factor, Type κλπ.  

Το πεδίο ID περιέχει το ID της χρονοσειράς. Το πεδίο Factor περιέχει πολλαπλασιαστικό 
συντελεστή ο οποίος αν δεν εισαχθεί, αποθηκεύεται η τιµή «1». Ο πολλαπλασιαστικός 
συντελεστής µπορεί να είναι π.χ. ο συντελεστής υψοµετρικής αναγωγής της βροχόπτωσης. 

Ο τύπος της χρονοσειράς καθορίζεται από την λίστα “Type”. Σύµφωνα µε τον τύπο, 
καθορίζονται τα δυνατά πεδία εισαγωγής (Factor, Consider First of the Month, Inflow is 
Runoff). 

Η επισήµανση “Consider First of the Month”, όταν είναι ενεργή, λαµβάνεται η τιµή η 
κοντινότερη στην αρχή του µήνα. Αυτή είναι η προτεινόµενη επιλογή για τις περισσότερες 
περιπτώσεις πλην των βροχοπτώσεων όπου ενδεχοµένως πρέπει να γίνει συνάθροιση όλων 
των τιµών βροχόπτωσης (οπότε και η επισήµανση πρέπει να είναι απενεργοποιηµένη). Η 
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επιλογή είναι µη ενεργή σε όλους τους τύπους χρονοσειρών (οπότε και τίθεται αυτόµατα 
ενεργή για διαρροή, απόθεµα, επιφάνεια, εξάτµιση και ανενεργή για βροχόπτωση) εκτός από 
την περίπτωση της εισροής /εκροής όπου ο χρήστης πρέπει να καθορίσει την επισήµανση 
σύµφωνα µε την φύση της χρονοσειράς. 

Η επισήµανση “Inflow is runoff” έχει νόηµα όταν κάποια χρονοσειρά εισροής είναι η 
απορροή της λεκάνης. Όταν είναι ενεργή, θα γραφτεί χρονοσειρά υψών απορροής βάση των 
χρονοσειρών εισροής µε ενεργή την παραπάνω επισήµανση εκτός αν έχει καθοριστεί πως το 
αποτέλεσµα είναι η απορροή (Result is runoff). 

Τέλος ο χρήστης µπορεί να αλλάξει δεδοµένα σε επιλεγµένες χρονοσειρές, να τις διαγράψει ή 
να αλλάξει την προτεραιότητά τους µε χρήση των κουµπιών “Change”, “Remove”, “Up”, 
“Down”. Η προτεραιότητα των χρονοσειρών έχει νόηµα σε κλάσεις χρονοσειρών όπου 
υπάρχει επικάλυψη. Η προτεραιότητα δίνεται στις ανώτερες χρονοσειρές της λίστας. 

Για τους τύπους “Inflow” και “Outflow” πρέπει να καθοριστεί και η κλάση (π.χ. για το Inflow 
µπορεί να είναι υδραγωγείο (aqueduct1~4), γεώτρηση κλπ, ενώ για το Outflow µπορεί να 
είναι υδροληψία (water supply), άρδευση (irrigation) κλπ). 
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8 Παραρτήµατα 

Παράρτηµα 1: Βοηθητικό λογισµικό για την έκδοση δελτίων αποθεµάτων 
Στα πλαίσια του έργου: «Εκσυγχρονισµός της εποπτείας και διαχείρισης του συστήµατος των 
υδατικών πόρων ύδρευσης της Αθήνας», αναπτύχθηκε το λογισµικό “Reporting manager”. 
Το συγκεκριµένο λογισµικό παράγει δελτία σε µορφή εκτυπώσιµου κειµένου που αφορούν 
δύο κατηγορίες: 

��∆ελτία του λογισµικού «Υδρονοµέας» που αφορούν σενάρια διαχείρισης. 
��∆ελτία αποθεµάτων ταµιευτήρων και κατανάλωσης διυλιστηρίων του υδροδοτικού 

συστήµατος της Αθήνας (ΕΥ∆ΑΠ). 

Η δεύτερη κατηγορία των δελτίων εξυπηρετούν το λογισµικό «Υδρογνώµων», παράγοντας 
εκτυπώσιµες µορφές των χρονοσειρών που αφορούν τα αποθέµατα των ταµιευτήρων καθώς 
και των καταναλώσεων των διυλιστηρίων. 

Τα αποθέµατα αφορούν τους τέσσερις ταµιευτήρες του υδροδοτικού συστήµατος της Αθήνας, 
δηλαδή: Μαραθώνας, Υλίκη, Μόρνος και Εύηνος. Τα στοιχεία που αντλούνται από την βάση 
είναι τα παρακάτω: 

��Ηµερήσιες χρονοσειρές µε τις στάθµες των ταµιευτήρων. Η καταγραφή της στάθµης 
γίνεται κάθε ηµέρα στις 08:00 π.µ. Συνεπώς αντλούνται οι ηµερήσιες εγγραφές που 
αφορούν την στάθµη στις 08:00. Εάν χρησιµοποιηθούν ωριαίες χρονοσειρές ή 
χρονοσειρές δέκα λεπτών, θα αντλούνται εγγραφές από κάθε ηµέρα στις 08:00. Εάν δεν 
υπάρχουν δεδοµένα για τις 08:00 κάθε ηµέρας δεν θα υπολογιστεί το ηµερήσιο απόθεµα. 

��Καµπύλες στάθµης - αποθέµατος - επιφάνειας. Βάσει αυτών των καµπύλων υπολογίζεται 
το απόθεµα κάθε ταµιευτήρα, καθώς και ο υπολογισµός του όγκου υπερχείλισης και του 
νεκρού όγκου. 

��Ηµερήσιες χρονοσειρές µε τις καταναλώσεις των διυλιστηρίων. Η καταγραφή της 
κατανάλωσης γίνεται κάθε ηµέρα στις 00:00 και αφορά την κατανάλωση για την ηµέρα 
που αρχίζει σε αυτήν την χρονική στιγµή. (Για παράδειγµα η εγγραφή στις 
26/09/2003 00:00 αφορά την κατανάλωση από 26/09/2003 00:00 έως 
26/09/2003 23:59.59). Η άντληση των δεδοµένων γίνεται για τις χρονικές στιγµές 00:00 
και αν δεν υπάρχουν δεδοµένα για αυτές τις χρονικές στιγµές δεν θα υπολογιστεί η 
κατανάλωση των διυλιστηρίων. 

Χρήση του λογισµικού 
Αφού γίνει η εκκίνηση του λογισµικού (Reporting Manager), θα εµφανιστεί η αρχική οθόνη 
όπου ο χρήστης επιλέγει την εφαρµογή για την οποία θα εκτυπωθούν δελτία. Η αρχική οθόνη 
επιτρέπει την επιλογή έκδοσης δελτίων του «Υδρονοµέα» ή της «ΕΥ∆ΑΠ» (δελτία 
αποθεµάτων). 
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Σχήµα 8.1: Η πρώτη σελίδα για την επιλογή του τύπου δελτίου. 

 
Ο χρήστης στην συνέχεια επιλέγει «∆ελτία αποθεµάτων και κατανάλωσης ΕΥ∆ΑΠ». 
Εµφανίζεται η παρακάτω οθόνη: 

 
Σχήµα 8.2: Η δεύτερη σελίδα για τις επιλογές των δελτίων - δελτία αποθεµάτων. 

 
Ο χρήστης επιλέγει την ηµεροµηνία υπολογισµών. Σύµφωνα µε αυτήν την ηµεροµηνία: 

��Υπολογίζονται τα δεδοµένα για το ηµερήσιο δελτίο για την ηµεροµηνία που έχει δηλωθεί. 
��Υπολογίζονται τα δεδοµένα για το µηνιαίο δελτίο για τον µήνα που αντιστοιχεί στην 

ηµεροµηνία που έχει δηλωθεί. 

Πίεση του κουµπιού «Σήµερα», προκαλεί την ρύθµιση της ηµεροµηνίας υπολογισµών στην 
τρέχουσα ηµεροµηνία του συστήµατος. 

Ο χρήστης µπορεί να πατήσει την ένδειξη «Ρυθµίσεις» ώστε να τροποποιήσει τους κωδικούς 
(ID) των χρονοσειρών από τις οποίες αντλούνται δεδοµένα καθώς και τα ID των καµπυλών 
στάθµης - αποθέµατος. Οι µεταβολές γίνονται χρησιµοποιώντας την παρακάτω φόρµα: 
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Σχήµα 8.3: Ρυθµίσεις για τα δελτία. 

 
Ο χρήστης εισάγει τα ID των χρονοσειρών καθώς και των καµπυλών παρεµβολής (στάθµη - 
απόθεµα ταµιευτήρα), τις κατώτατες στάθµες (έτσι ώστε να ορίζεται ο νεκρός όγκος) καθώς 
και τις στάθµες υπερχείλισης. 

Οι ρυθµίσεις θα αποθηκευτούν στη ρεσεψιόν (Registry) του συστήµατος αν πατηθεί από τον 
χρήστη το µενού File→Write values to registry. Έτσι οι ρυθµίσεις ανακτώνται κάθε φορά που 
γίνεται η εκκίνηση του προγράµµατος. Επιπλέον υπάρχει η δυνατότητα επαναφοράς των 
αρχικών εργοστασιακών ρυθµίσεων πατώντας το µενού: File→Reset to default. 

Εκτύπωση δελτίων 
Ο χρήστης επιλέγει την διαδικασία της «Προεπισκόπισης» ή της άµεσης «Εκτύπωσης» µέσω 
των αντίστοιχων ενδείξεων. 

Κάθε ένα από τα «Μηνιαίο δελτίο» ή «Ηµερήσιο δελτίο» καταλαµβάνει τον χώρο µίας 
σελίδας Α4, παρουσιάζονται δε στην συνέχεια: 

 
Σχήµα 8.4: Ηµερήσιο δελτίο αποθεµάτων και καταναλώσεων. 
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Εκτός από τα αριθµητικά δεδοµένα για τα αποθέµατα και τις καταναλώσεις, παρουσιάζεται 
σε µορφή γραφήµατος η πλήρωση των ταµιευτήρων (σε ποσοστό %). Ο ωφέλιµος όγκος 
αναπαριστάται µε µπλε διαγώνιες γραµµές, ο νεκρός όγκος µε κόκκινες διασταυρούµενες 
γραµµές ενώ ο όγκος έως την υπερχείλιση µε πράσινες σταυρωτές γραµµές. Στην περίπτωση 
όπου το απόθεµα είναι µη απολήψιµο (µικρότερο από το νεκρό όγκο), παρουσιάζεται µε 
κίτρινες διαγώνιες γραµµές ο όγκος που απαιτείται ώστε το απόθεµα να καταστεί απολήψιµο. 

 
Σχήµα 8.5: Μηνιαίο δελτίο αποθεµάτων. 

 
Η παρουσιαζόµενη ως µεταβολή από το τέλος του προηγούµενο µήνα, αφορά την µεταβολή 
από την τελευταία ηµέρα του προηγούµενου µήνα έως την τελευταία µη κενή εγγραφή του 
τρέχοντος µήνα. 
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Παράρτηµα 2: Περιγραφή ορισµένων επεξεργασιών του λογισµικού 
«Υδρογνώµων» 
Οι παρακάτω παράγραφοι προέρχονται από την τεκµηρίωση που παρέχεται στους 
προγραµµατιστές. Τα τµήµατα που επιλέχθηκαν να µεταφερθούν στο παρών τεύχος, βοηθάνε 
στην καλύτερη κατανόηση των επεξεργασιών του λογισµικού «Υδρογνώµων» και στην 
ορθότερη χρήση του. 

Ηµεροµηνία εγγραφής χρονοσειράς (Date, Time-stamp) 
Οι ηµεροµηνίες των εγγραφών αποθηκεύονται ως χρονικές στιγµές, σε πολλές όµως 
περιπτώσεις οι εγγραφές µία χρονοσειρά αφορούν χρονικά διαστήµατα και όχι χρονικές 
στιγµές. Μόνο οι εγγραφές χρονοσειρών στιγµιαίων µεγεθών αποτυπώνουν χρονικές στιγµές, 
ωστόσο σε όλες τις άλλες περιπτώσεις (χρονοσειρές συναθροισµένων µεγεθών, µέσων τιµών 
κλπ) η αναφορά µίας εγγραφής αφορά ένα χρονικό διάστηµα. 

Για τις χρονοσειρές ηµερήσιου βήµατος ή µικρότερου, η ηµεροµηνία (η οποία περιέχει και 
την «ώρα») αναφέρεται στο τέλος του χρονικού διαστήµατος. Για παράδειγµα σε µία 
ηµερήσια χρονοσειρά που έχει προκύψει από συνάθροιση, η εγγραφή 2002-03-08 08:00, 
αφορά το χρονικό διάστηµα που ξεκινά από 2002-03-07 08:00 και τελειώνει στις 2002-03-
08 08:00. 

Για τις µηνιαίες χρονοσειρές, η ηµέρα του µήνα και η ώρα δεν έχουν νόηµα, έτσι η εγγραφή 
θα αποθηκεύεται στην πρώτη του µήνα και ώρα 00:00. Για παράδειγµα η τιµή που αφορά τον 
Μάρτιο του 2003 θα αποθηκευτεί την χρονική στιγµή 2002-03-01 00:00. 

Για τις ετήσιες χρονοσειρές γίνεται η διάκριση αν χρησιµοποιείται ηµερολογιακό ή 
υδρολογικό έτος. Στην πρώτη περίπτωση η εγγραφή θα αποθηκεύει χρονική στιγµή την 
πρώτη Ιανουαρίου του έτους ώρα 00:00 ενώ για υδρολογικό έτος την πρώτη Οκτωβρίου του 
έτους. Για παράδειγµα η εγγραφή του υδρολογικού έτους 2002-03 θα αποθηκευτεί την 2002-
10-01 00:00. 

Χρονική µετατόπιση (Date offset) 
Στην περίπτωση όπου το χρονικό βήµα είναι σταθερό, οι χρονικές στιγµές των εγγραφών της 
χρονοσειράς, έχουν το ίδιο υπόλοιπο όταν διαιρούνται µε το χρονικό βήµα. Για παράδειγµα, 
σε µία ηµερήσια χρονοσειρά, οι χρονικές στιγµές των εγγραφών µπορούν να είναι στις 00:00 
όπου δίνει υπόλοιπο 0 και χρονική µετατόπιση, ή µπορούν να είναι στις 08:00, οπότε και η 
χρονική µετατόπιση θα είναι 8 ώρες. Η παράµετρος “Date Offset” δίνει αυτήν την χρονική 
µετατόπιση σε ηµέρες. Για δεκάλεπτες χρονοσειρές, τα σηµεία µηδενικής µετατόπισης είναι 
τα πολλαπλάσια των δέκα λεπτών (:10, :20, κλπ), για ωριαίες χρονοσειρές, τα σηµεία 
µηδενικής χρονικής µετατόπισης είναι οι ακέραιες ώρες. 

Ο χρήστης δεν µπορεί να ορίσει την χρονική µετατόπιση για χρονοσειρές δεκάλεπτου, 
ωριαίου και ηµερήσιου χρονικού βήµατος. Η χρονική µετατόπιση σε αυτές τις περιπτώσεις 
ορίζεται αυτόµατα εφόσον βέβαια η χρονοσειρά έχει αυστηρό χρονικό βήµα (Time step 
strict). Η χρονική µετατόπιση ορίζεται αυτόµατα από την διαφορά της πρώτης εγγραφής µε 
την ακέραιη χρονική διαίρεση. Αφού οριστεί η χρονική µετατόπιση, οι νέες εγγραφές που 
προστίθενται θα πρέπει να είναι µετατοπισµένες κατά την χρονική µετατόπιση. (Για 
παράδειγµα αν η χρονική µετατόπιση είναι 8 ώρες, αν επιχειρήσω να εισάγω την εγγραφή 
στις 2003-10-01 09:00, το σύστηµα θα µε αποτρέψει). 

Όσον αφορά τις χρονοσειρές µε µηνιαίο ή ετήσιο χρονικό βήµα, µόνο το έτος ή και ο µήνας 
παίζουν ρόλο καθώς η ηµέρα, ώρα έχουν τεθεί αυτόµατα σε 1 και 00:00. Η χρονική 
µετατόπιση θα είναι µηδενική αν αναφερόµαστε στην χρονική στιγµή της αρχής του χρονικού 
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διαστήµατος (π.χ. 1η του µήνα ή 1η του έτους), µπορεί να λάβει όµως και κάποια τιµή (θετική 
ή αρνητική). Για παράδειγµα µία χρονική µετατόπιση +2 ηµερών και 13 ωρών, προκειµένου 
για τις συναθροισµένες τιµές του µήνα Μάρτιος 2002, το διάστηµα συνάθροισης θα είναι από 
2 Μαρτίου 13:00 έως 2 Απριλίου 13:00. Το αυτό ισχύει και για τις χρονοσειρές ετήσιου 
χρονικού βήµατος 

Χρονικό βήµα χρονοσειράς (Timeseries: Time step) 
Το χρονικό βήµα της χρονοσειράς µπορεί να λάβει µία από τις παρακάτω τιµές: 

��Μεταβλητό (variable) 
��∆εκάλεπτο (ten minute) […, 23:00, 23:10, 23:20,…] 
��Ωριαίο (hourly) […, 03:00, 04:00, 05:00, …] 
��Ηµερήσιο (daily) […, 2003-10-01, 2003-10-02, 2003-10-03, …] 
��Μηνιαίο (monthly) […, 2003/10, 2003/11, 2003/12, …] 
��Ετήσιο (yearly) [2001, 2002, 2003] 

Αυστηρό χρονικό βήµα χρονοσειράς (Timeseries: Time step strict) 
Τα χρονικά βήµατα µικρότερα του µηνιαίου, είναι δυνατόν να περιέχουν ανωµαλίες. Για 
παράδειγµα, σε µία χρονοσειρά ηµερήσιου χρονικού βήµατος, οι µετρήσεις µπορούν να είναι 
καταγεγραµµένες π.χ. στις 08:00 κάθε πρωί, όµως ορισµένες φορές να έχουν καταγραφεί στις 
09:00, 10:00 π.χ. λόγω καθυστέρησης του συνεργείου που κάνει τις µετρήσεις. Αντίστοιχα σε 
µία δεκάλεπτη χρονοσειρά, είναι δυνατό σε µία κανονική ακολουθία :10, :20, :30, κλπ, να 
εµφανιστούν ανωµαλίες µορφής: :41, :51, :01, :11 κλπ, π.χ. λόγω βλάβης της καταγραφικής 
µονάδας. Όταν αυτές οι ανωµαλίες επιτρέπονται να λαµβάνουν χώρα σε µία χρονοσειρά 
πρέπει η ιδιότητα Αυστηρό χρονικό βήµα (Time step strict) να είναι εκτός. 

Επιπλέον όταν το Αυστηρό χρονικό βήµα είναι εκτός, η χρονική µετατόπιση (date offset) δεν 
είναι δυνατό να οριστεί. Εντούτοις, όταν το Αυστηρό χρονικό βήµα είναι ορισµένο (εντός), 
ορίζεται αυτόµατα εντός και η χρονική µετατόπιση και προκειµένου για χρονοσειρές 
δεκάλεπτου, ωριαίου ή ηµερήσιου χρονικού βήµατος, υπολογίζεται αυτόµατα. Αν ο χρήστης 
επιχειρήσει να θέσει εντός το Αυστηρό χρονικό βήµα, γίνεται ένας εσωτερικός έλεγχος και αν 
υπάρχουν ανωµαλίες, αποτρέπεται η θέση εντός. 

Για χρονοσειρές µηνιαίου και ετήσιου χρονικού βήµατος, η ιδιότητα του Αυστηρού Χρονικού 
Βήµατος είναι εξ΄ αρχής εντός και δεν µπορεί να τεθεί εκτός. 

Μία χρονοσειρά ηµερήσιου ή µικρότερου χρονικού βήµατος θα πρέπει να γίνεται Αυστηρού 
χρονικού βήµατος µε χρήση της κατάλληλης επεξεργασίας (αναίρεση χρονικών διαταραχών - 
Regularize step) και όχι µε αυθαίρετη ρύθµιση από τον χρήστη. 

Κανονικοποίηση χρονικού βήµατος - άρση χρονικών διαταραχών (Regularize step) 
Ο σκοπός αυτής της επεξεργασίας είναι η άρση των τυχών χρονικών διαταραχών που περιέχει 
µία χρονοσειρά σταθερού χρονικού βήµατος. Η επεξεργασία αυτή είναι δυνατή στις 
χρονοσειρές που έχουν δεκάλεπτο, ωριαίο ή ηµερήσιο χρονικό βήµα. 

Το αποτέλεσµα της επεξεργασίας θα είναι µία νέα χρονοσειρά που θα έχει Αυστηρό χρονικό 
βήµα. Προκειµένου να γίνει η επεξεργασία είναι υποχρεωτικό να οριστεί η χρονική 
µετατόπιση που θα έχει η χρονοσειρά αποτελέσµατος. Για παράδειγµα σε µία δεκάλεπτη 
χρονοσειρά αν ζητηθεί µία χρονική µετατόπιση 2 λεπτών, το αποτέλεσµα θα είναι µία 
χρονοσειρά σε χρόνους :02, :12, :22, :32, :42, :52. 

Κατά την επεξεργασία, µετατοπίζονται οι τιµές σε ακέραιες χρονικές διαιρέσεις (+ την τυχόν 
χρονική µετατόπιση που ζητάει ο χρήστης) έτσι ώστε να αποκτηθεί το Αυστηρό χρονικό βήµα. 
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Οι τιµές µπορεί να µεταβάλλονται σύµφωνα µε τον αλγόριθµο που εφαρµόζεται. 
∆ιαφορετικός αλγόριθµος εφαρµόζεται προκειµένου για κανονικοποίηση στιγµιαίων ή 
αθροιστικών χρονοσειρών ή ανυσµατικών. Επιπλέον δίνεται η δυνατότητα στον χρήστη της 
απλής µετατόπισης χωρίς µεταβολής των τιµών. 

Επεξεργασία συνάθροισης χρονοσειρών - εξαγωγής χρονοσειράς µεγαλύτερου χρονικού 
βήµατος (Aggregation) 
Η επεξεργασία αυτή εξάγει µία χρονοσειρά µεγαλύτερου χρονικού βήµατος µέσω 
επεξεργασίας συνάθροισης, εύρεσης µέσων τιµών, µεγίστων, ελαχίστων κλπ. Για να είναι 
δυνατή η επεξεργασία, πρέπει η αρχική χρονοσειρά να είναι Αυστηρού χρονικού βήµατος. Αν 
δεν είναι θα πρέπει να υποστεί την επεξεργασία άρσης χρονικών ανωµαλιών προτού υποστεί 
την επεξεργασία της συνάθροισης. Το αποτέλεσµα θα είναι µία χρονοσειρά µεγαλύτερου 
χρονικού βήµατος που θα διαθέτει επίσης Αυστηρό χρονικό βήµα. 

Η επεξεργασία γίνεται ως εξής: 

��Οι δεκάλεπτες χρονοσειρές συναθροίζονται σε ωριαίες 
��Οι ωριαίες χρονοσειρές συναθροίζονται σε ηµερήσιες 
��Οι ηµερήσιες χρονοσειρές συναθροίζονται σε µηνιαίες 
��Οι µηνιαίες χρονοσειρές συναθροίζονται σε ετήσιες 

Ο χρήστης πρέπει να καθορίσει την ενδεχόµενη χρονική µετατόπιση (π.χ. για ηµερήσιες 
χρονοσειρές να καθορίσει 480 λεπτά προκειµένου οι τιµές να συναθροίζονται από 08:00 έως 
08:00). Για την παραγωγή µηνιαίας χρονοσειράς πρέπει να εισαχθεί η τυχόν χρονική 
µετατόπιση που θα έχει η αρχική ηµερήσια χρονοσειρά. 

Η συνάθροιση γίνεται ως εξής: 

Για παραγωγή ωριαίων χρονοσειρών, χρησιµοποιείται η τιµή της εγγραφής της δεκάλεπτης 
χρονοσειράς που συµπίπτει µε την παραγόµενη ωριαία καθώς και των πέντε εγγραφών που 
προηγούνται. 

Για παραγωγή ηµερήσια χρονοσειράς, χρησιµοποιείται η τιµή της εγγραφής της ωριαίας 
χρονοσειρά που συµπίπτει µε την παραγόµενη ηµερήσια καθώς και των 23 εγγραφών που 
προηγούνται. 

Για την παραγωγή µηνιαίας χρονοσειράς όπου η εγγραφή θα καταγραφεί στην χρονική 
στιγµή 01/ΜΜ/ΕΕΕΕ 00:00, η συνάθροιση γίνεται από Ν εγγραφές, όπου Ν οι ηµέρες του 
µήνα ΜΜ/ΥΥΥΥ. Οι εγγραφές που χρησιµοποιούνται στην συνάθροιση είναι αυτές όπου οι 
χρονικές στιγµές τους συµπίπτουν µε την αρχή του µήνα ΜΜ/ΥΥΥΥ + την ενδεχόµενη 
χρονική µετατόπιση και των επόµενων Ν-1 εγγραφών. 

Με παρόµοιο τρόπο γίνεται η παραγωγή της ετήσια χρονοσειράς από την συνάθροιση 
εγγραφών µηνιαίας χρονοσειράς. Ο χρήστης θα καθορίζει αν η παραγόµενη χρονοσειρά 
αναφέρεται σε υδρολογικό έτος (οπότε συναθροίζονται τα δεδοµένα από τον Οκτώβριο έως 
τον Σεπτέµβριο) ή σε ηµερολογιακό έτος (δεδοµένα από τον Ιανουάριο έως τον ∆εκέµβριο). 



 82

Παράρτηµα 3: Περιγραφή των αρχείων κειµένου του λογισµικού 
«Υδρογνώµων» 
Το λογισµικό «Υδρογνώµων» διαθέτει την δυνατότητα αποθήκευσης και ανάκτησης σε / από 
αρχεία κειµένου (text Files). Ο χρήστης µπορεί να δηµιουργήσει τέτοια αρχεία µε έναν κοινό 
επεξεργαστή κειµένου (όπως οι Microsoft Notepad, Ultra Edit, vi, emacs κ.α.) και κατόπιν να 
τα εισάγει στο σύστηµα το λογισµικό «Υδρογνώµων». Επιπλέον µέσω της αποθήκευσης 
τέτοιων αρχείων είναι δυνατή η άµεση επέµβαση στα δεδοµένα ή η συγγραφή έτερου 
λογισµικού που θα ανακτά αυτά τα δεδοµένα προς επεξεργασία. 

Τα αρχεία κειµένου του λογισµικού «Υδρογνώµων» είναι τα παρακάτω: 

��Αρχεία κειµένου χρονοσειρών. 
��Αρχεία κειµένου µε καµπύλες στάθµης - παροχής υδατορεύµατος. 
��Αρχεία κειµένου µε καµπύλες στάθµης - επιφάνειας - αποθέµατος ταµιευτήρων. 
��Αρχεία κειµένου µε τα δεδοµένα για τον υπολογισµό του ισοζυγίου ταµιευτήρων. 

Αρχεία χρονοσειρών 
Παρουσιάζεται ένα τµήµα από το αρχείο κειµένου, κατόπιν επεξηγείται. Στο πρώτο τµήµα 
του αρχείου περιγράφονται γενικότερες ιδιότητες της χρονοσειράς. Στο δεύτερο τµήµα 
παρατίθενται οι εγγραφές της χρονοσειράς. 
Delimiter=";" 
FlagDelimiter=" " 
DecimalSeparator="." 
DateFormat="yyyy-mm-dd hh:nn" 
MUnit="mm" 
Count=515 
TimeStep=4 
DateOffset= 
Flags="COMMENT=1 RANGE=2 SPATIAL=2 TEMPORAL=2 INTERNAL=2 ESTIMATED=1 SUSPECT=1 SNOW=1 ICE=1 
FROST=1 DIVE=1 OVERFLOW=1 PUMP=1 LOGOVERRUN=1 LOGNOISY=1 LOGOUTSIDE=1 LOGRANGE=1 HOMOGEN=2 
INFILLING=1 PENMAN=1 DATEINSERT=1 INCONSISTENT=1 AUTO=1 MISSING=1 USER0=1 USER1=1 USER2=1" 
Variable=0 
VariableType=Instantaneous 
Title="3 (mm)" 
Comment="Μετρητικός σταθµός: Άµφισσα" 
Comment="Variable: Βροχόπτωση" 
Comment="Measurement unit: mm" 
Comment="Step: Μηνιαίο" 
Comment="Επεξεργασµένη" 
 
1954-11-01 00:00;; 
1954-12-01 00:00;60.50; 
1955-01-01 00:00;72.70; 
1955-02-01 00:00;58.90; 
1955-03-01 00:00;24.60; 
1955-04-01 00:00;54.00; 
1955-05-01 00:00;; 
1955-06-01 00:00;0.50; 
1955-07-01 00:00;14.00; 
1955-08-01 00:00;0.40; 
1955-09-01 00:00;76.70; 
1955-10-01 00:00;194.10; 
1955-11-01 00:00;175.70; 

 

Delimiter=”;” Ο διαχωριστής είναι το ελληνικό ερωτηµατικό. Ο διαχωριστής 
χρησιµοποιείται για να διαχωρίσει τα στοιχεία των εγγραφών (ηµεροµηνία, 
σηµαίες, τιµές). 

FlagDelimiter=” “ Ο διαχωριστής των σηµαιών είναι το κενό. 

DecimalSeparator=”.” Το σύµβολο της υποδιαστολής είναι η τελεία. 
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DateFormat=”yyyy-mm-dd hh:nn” Ο τρόπος περιγραφής των χρονικών στιγµών (έτος - µήνας 
- ηµέρα ώρα και πρώτα λεπτά). 

MUnit=”mm” Ο συµβολισµός της µονάδας µέτρησης, στην προκειµένη περίπτωση 
χιλιοστά του µέτρου. 

Count=515 Ο αριθµός των εγγραφών της χρονοσειράς. 

TimeStep=4 Το χρονικό βήµα το οποίο µπορεί να είναι κάποιο από τα 0: άγνωστο, 1: 
δεκάλεπτο, 2: ωριαίο, 3: ηµερήσιο, 4: µηνιαίο, 5: ετήσιο, 6: µεταβλητό. 

DateOffset= Η χρονική µετατόπιση, η οποία ορίζεται αν χρειάζεται κάτι τέτοιο. (στην 
προκειµένη περίπτωση δεν έχει οριστεί). 

Flags= Οι ονοµασίες των σηµαιών και πόσα bit καταλαµβάνουν (1 ή 2). 

TimeStepStrict= Αυστηρό χρονικό βήµα, τίθεται True (εντός) ή False (εκτός). 

Variable=0 Κωδικός της µεταβλητής. Υπάρχουν 29 κωδικοί καταχωρηµένοι στην βάση. 
Ο κωδικός αυτός µπορεί να µην χρησιµοποιηθεί καθώς η πληροφορία αυτή 
εµπεριέχεται στην βάση. 

Title=”...” Ο τίτλος που εµφανίζεται. 

Comment=”...” ∆ιάφορα σχόλια. 

[Κενή γραµµή] 

1954-11-01 00:00;; Εγγραφή, ηµεροµηνία; σηµαίες; τιµή 

Αρχεία καµπυλών στάθµης - παροχής 
Παρουσιάζεται ένα τµήµα από το αρχείο κειµένου, κατόπιν επεξηγείται. Στο πρώτο τµήµα 
του αρχείου περιγράφονται γενικές ιδιότητες. Στο δεύτερο παρατίθενται οι καµπύλες. Κάθε 
καµπύλη περιγράφεται (ηµεροµηνίες ισχύος) και τελικά δίνονται τα σηµεία της καµπύλης. 
Delimiter="," 
DecimalSeparator="." 
DateFormat="yyyy/mm/dd hh:nn" 
Count=5 
 
StartDate=1992/11/01 00:00 
EndDate=1995/12/11 23:59 
Extension=False 
Logarithmic=True 
Offset= 7.00000000000000E-0001 
PointsCount=3 
 
0.2,2.94 
0.9,38.73 
2.97,253.26 
StartDate=1995/12/12 00:00 
EndDate=1997/01/13 23:59 
Extension=False 
Logarithmic=True 
Offset= 7.00000000000000E-0001 
PointsCount=3 
 
0.04,2.25 
0.78,61 
2.62,185.12 
StartDate=1997/01/14 00:00 
EndDate=1999/01/11 23:59 
Extension=False 
Logarithmic=True 
Offset= 7.00000000000000E-0001 
PointsCount=3 
 
-0.29,1.56 
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0.27,22.68 
0.65,55.61 
StartDate=1999/01/12 00:00 
EndDate=2000/12/31 23:59 
Extension=False 
Logarithmic=True 
Offset= 7.00000000000000E-0001 
PointsCount=3 
 
-0.09,2.94 
0.38,27.32 
0.65,43.42 
StartDate=1992/11/01 00:00 
EndDate=2000/12/31 23:59 
Extension=True 
Logarithmic=True 
Offset= 7.00000000000000E-0001 
PointsCount=2 
 
3,338.7 
7,1207 
 

Delimiter=”,” Το σύµβολο του διαχωριστή. Σύµφωνα µε αυτό το σύµβολο, διαχωρίζονται 
οι δεκαδικές τιµές των σηµείων της καµπύλης. 

DecimalSeparator=”.” Το σύµβολο της δεκαδικής υποδιαστολής. 

DateFormat=”yyyy/mm/dd hh:nn” Ο τρόπος περιγραφής των χρονικών στιγµών (έτος - µήνας 
- ηµέρα ώρα και πρώτα λεπτά). 

Count=5 Ο αριθµός των καµπύλων. 

[ΚΕΝΗ ΓΡΑΜΜΗ - ακολουθεί η περιγραφή των καµπύλων] 

StartDate= Η ηµεροµηνία της έναρξης ισχύος της καµπύλης. 

EndDate= Η ηµεροµηνία της λήξης ισχύος της καµπύλης. 

Extension=False Η καµπύλη αυτή δεν είναι καµπύλη επέκτασης (False). 

Logarithmic=True Θα χρησιµοποιηθεί λογαριθµική παρεµβολή εφόσον είναι εντός 
(True) ή γραµµική εφόσον είναι εκτός (False). 

Offset= Η αρχή µέτρησης της στάθµης. 

PointsCount= Ο αριθµός των σηµείων της καµπύλης. 

[ΚΕΝΗ ΓΡΑΜΜΗ - ακολουθούν τα σηµεία της καµπύλης] 

0.2,2.94 Το πρώτο σηµείο της καµπύλης. 

… 

2.97,253.26 Το τελευταίο σηµείο της καµπύλης. 

[χωρίς κενή γραµµή ακολουθεί η περιγραφή της δεύτερης καµπύλης] 

Αρχεία καµπυλών στάθµης - επιφάνειας - αποθέµατος 
Τα αρχεία αυτά περιέχουν γραµµές µε τις εγγραφές στάθµης- επιφάνειας - αποθέµατος. 

Οι τιµές χωρίζονται µε κάποιο σύµβολο που καθορίζει ο χρήστης κατά την εκτέλεση του 
λογισµικού «Υδρογνώµων». 


